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New and Changed Help Topics - IATS Version 8.7.3 

The following Help topic was updated to comply with DFAS SCR # 27605: 

 Creating Taxable TDY Orders:  This Help topic was updated, to add a note 
stating that this feature only applies to civilian travel.  In addition, the text was 
removed that addressed the Default State and State Tax Designation fields as 
they are no longer used. 

The following Help topics were updated to comply with DFAS SCR # 27667: 

 TQSE Overview:  This Help topic was updated, to add a note stating that Actual 
will no longer be allowed as a TQSE type for orders issued on or after 1 February 
2025. 

 What's Authorized - CIVPCS Order:  This Help topic was updated, to add a 
note stating that Actual will no longer be listed as a TQSE type for orders issued 
on or after 1 February 2025. 

 Completing the TQSE Daily Expenses Screen:  This Help topic was updated, 
to add a note stating that Actual will no longer be allowed as a TQSE type for 
orders issued on or after 1 February 2025. 

 Adjusting the Dates on the Daily TQSE Expenses Screen:  This Help topic 
was updated, to add a note stating that Actual will no longer be allowed as a 
TQSE type for orders issued on or after 1 February 2025. 

 Applying the PDDA Actual Expense Allowance:  This Help topic was updated, 
to add a note stating that Actual will no longer be allowed as a TQSE type for 
orders issued on or after 1 February 2025. 
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Introduction 

Overview 

The Integrated Automated Travel System (IATS) is a Windows ® based application developed by 
Professional Software Consortium, Inc. to serve as travel claims processing system for use by the 
Department of Defense (DOD) and various other government agencies. IATS fully automates the entire 
claim processing cycle - from tracking in-coming claims to reporting expenditures. 

Following, is a list of the major processes automated by IATS: 

 Tracking in-coming requests 

 Issuance of travel advances 

 Computation of settlement requests 

 Disbursement capability to produce US Treasury checks 

 Disbursement capability via Electronic Funds Transfer (EFT) 

 History of all travel transactions 

 Debt management 

 Interfaces to Accounting, Budget, Disbursing, and Personnel systems 

 Interfaces with electronic mail systems. 
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About IATS 

The Integrated Automated Travel System (IATS) is a Windows ® based application developed by 
Professional Software Consortium, Inc. to serve as travel claims processing system for use by the 
Department of Defense (DOD) and various other government agencies. IATS fully automates the entire 
claim processing cycle - from tracking in-coming claims to reporting expenditures. 

After Logging into IATS, the IATS for Windows screen appears for the View associated with the users 
account. 

 

At the IATS for Windows screen, you can click on the Help option on the tool bar and then select About 
IATS to access information on the following items: 

 System Info 

 IATS Debug Log File 

 License Info 

 Load License 

 CAC Info 

After clicking on the About IATS option, the following About IATS screen will appear: 
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Click on the See Also button below and select the topic that provides detailed instructions for any of 
the information options listed above. 
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Login 

In order to use IATS, all users must login using a unique Username and Password combination.  This 
ensures only persons with proper authorization use IATS to process travel claims. 

Start IATS by clicking on the associated icon on the PC desktop. The following User-Login screen 
appears: 

 

Complete the following steps to "login" to IATS: 
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1. Database: - If ODBC connections have been set-up for more than one IATS database, you will 
see the Database field on the Log In screen. 

2. At the Database field, you can click on the down arrow button to see 
a list of other available databases and then click on the desired database if applicable. 

3. Once you have selected the desired database to log into, if applicable, click on the Next button. 
4. IATS will now display the User ID and Password fields. 
5. User Name: - At this field, type the assigned user name and press the Enter or Tab key to 

continue. 
6. Password: - At this field, type the assigned password and press the Enter or Tab key to 

continue. 
7. Click on the Log In button. 

Note: Passwords should only be known by the individual user. After logging into IATS for the first time, 
you are required to change the System Administrator created password to a new password known only 
to the user. In addition, users should frequently change their passwords - every 60 days is required.  If 
the user is logging into IATS for the first time, the Change Passwords screen appears and the user is 
required to change the Login password created by the System Administrator. 

8. The next screen to appear is the Privacy Act. 
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9. The Privacy Act statement appears to remind users that private information is protected by 

public law.  Click on the Yes, Proceed button to indicate understanding of the need to keep this 
information confidential and continue logging into IATS. 

10. The next screen to appear is the IATS Copyright screen.  This screen appears to let the user 
know that this software is the sole property of Professional Software Consortium, Inc. and 
may not be installed or used by any organization not possessing a license for it's use. 
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11. At the IATS Copyright screen, click in the circle next to the option Accept or Decline as 
applicable and then click on the OK button. 

12. After clicking on the OK button, the Rules of Behavior screen appears 
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13. You must read through the rules and if you comply, click on the OK button to continue. 
14. After clicking on the OK button at the Rules of Behavior screen, you will see a pop-up message 

displaying your Login Statistics.   
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15. Click on OK to continue. 
16. After clicking on the OK button, the IATS for Windows screen appears for the View associated 

with the users account. 

Note:  A feature was added to IATS "Prevent Old Version Login" that prevents IATS users without 
access to the Maintenance module to be able to login to IATS if the software is not current.  This 
feature is activated by a switch that can be turned on or off in the Maintenance module.  When this 
feature is activated, a user without access to maintenance privileges will see a message, when they 
attempt to login, stating Login is disabled because the IATS version is out of date and to contact 
their System Administrator.  A user with access to maintenance privileges will see a message, when 
they attempt to login, stating the IATS version is out of date and to contact their System 
Administrator.  They are, however, allowed to continue to login and use the obsolete version. 
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Login using Active Directory and CAC Authentication 

In order to use IATS, all users must login using a unique Username.  This ensures only persons with 
proper authorization use IATS to process travel claims. 

Start IATS by clicking on the associated icon on the PC desktop. 

Note:  When IATS starts it now automatically checks the userôs Windows Identity to determine if they 
are part of the IATS Active Directory Windows Network group.  If the Windows User is determined to 
not be in the IATS group, IATS will immediately display a message to inform the user that they are not 
in that group and will then exit.   

If the user passes the first test of ñgroup membershipò then IATS will display the following User Login 

screen. 
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Complete the following steps to "login" to IATS: 

1. Database: - If ODBC connections have been set-up for more than one IATS database, you will 
see the Select the IATS Database field on the User Login screen. 

2. At the Database field, you can click on the down arrow button to see 
a list of other available databases and then click on the desired database if applicable. 

3. Once you have selected the desired database to log into, if applicable, click on the Next button. 
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Note:  If IATS detects only one ODBC it will pre-select that ODBC and auto-click the Next button so that 
the first screen a user with such a configuration would see is CAC Certificate selection and 
authentication screen as shown below. 

 

4. If the Certificate shown by default is not the correct one the user must click the ñMore choicesò 

link in the lower-left to display a full list of certificates found on the CAC as shown below: 
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5. The user must select the certificate theyôve been instructed by DFAS to use and click OK to 

proceed. 

6. After selecting the appropriate certificate, the ActivClient Login screen appears. 
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7. Here the user must enter and validate their CAC PIN.  If the PIN is correct IATS will allow them 
to proceed. 

Note:  If this is the first time the user has logged into IATS, then IATS will display the Username selection 
screen where they will see the usual Username and Password fields.  The password field will be 
disabled and they will need to enter an IATS Username as instructed by the IATS administrator.  If the 
Username they enter is invalid or has been claimed and associated with another user/CAC IATS will 
display a message to let them know. 

8. The user will not enter a Password but will simply click the Log In button to continue. 

Note:  Once the user has logged in once and associated their CAC with an IATS Username they will no 
longer be prompted for a Username unless the IATS system administrator associates their CAC with 
one or more additional IATS user IDs.  In that case the user would see the Username and Password 
view of the login screen again.  As before, the Password field would be disabled.  In this case, however, 
the Username would be displayed as a drop down list of IATS Usernames found to be associated with 
their CAC.  They can then select the Username they want to use and click the Log In button to finish 
the IATS login process. 

9. When the user clicks the Log In button, or when IATS finds that their CAC certificate is already 
associated with just one IATS user account, IATS automatically displays the Privacy Act 
screen 
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10. The Privacy Act statement appears to remind users that private information is protected by 
public law.  Click on the Yes - Proceed button to indicate understanding of the need to keep this 
information confidential and continue logging into IATS. 

11. The next screen to appear is the IATS Copyright screen. This screen appears to let the user 
know that this software is the sole property of Professional Software Consortium, Inc. and 
may not be installed or used by any organization not possessing a license for it's use. 
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12. At the IATS Copyright screen, click in the circle next to the option Accept or Decline as 
applicable and then click on the OK button. 

13. After clicking on the OK button, the Rules of Behavior screen appears 
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14. You must read through the rules and if you comply, click on the OK button to continue. 
15. After clicking on the OK button at the Rules of Behavior screen, you will see a pop-up message 

displaying your Login Statistics.   
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16. Click on OK to continue. 
17. After clicking on the OK button, the IATS for Windows screen appears for the View associated 

with the users account. 

Note:  A feature was added to IATS "Prevent Old Version Login" that prevents IATS users without 
access to the Maintenance module to be able to login to IATS if the software is not current.  This 
feature is activated by a switch that can be turned on or off in the Maintenance module.  When this 
feature is activated, a user without access to maintenance privileges will see a message, when they 
attempt to login, stating Login is disabled because the IATS version is out of date and to contact 
their System Administrator.  A user with access to maintenance privileges will see a message, when 
they attempt to login, stating the IATS version is out of date and to contact their System 
Administrator.  They are, however, allowed to continue to login and use the obsolete version. 
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Selecting a new Theme 

In computing, a theme is a preset package containing graphical appearance details. A theme usually 
comprises a set of shapes and colors for the graphical control elements, the window decoration and the 
window. Themes are used to customize the look and feel of a piece of computer software or of an 
operating system. 

The IATS program was designed using a specific theme.  A feature was added, however, to allow an 
IATS user to change the default theme to another one if desired. 

Complete the following steps to "change" the default IATS theme: 

 

1. At the IATS for Windows screen, regardless of your view, click the Tools menu and then click 
on the Select New Theme option. 

2. You will see a variety of theme names appear. 
3. Click on the new theme you wish to select.  IATS will change the appearance to the selected 

theme. 
4. IATS may display the following warning message depending on the theme you select. 
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5. If this warning message appears, click on Yes or No as desired. 

 

6. If you wish to change the theme back to the default theme, click on the RESET option as 
shown above. 

Note:  It is recommended that you log out of IATS and log back in after resetting the theme since the 
fonts do not always reset as expected.. 
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Displaying your System Info 

On occasion, a representative from Professional Software Consortium (PSC) or DFAS may assist an 
IATS user with a particular error with the IATS software.  Often times, the representative may need to 
review the System Information for the user's PC. 

A feature was added to IATS that enables you to easily display the System Information for your 
computer. 

Complete the following steps to "display" the System Information for your computer: 

 
1. At the Menu bar at the top of the IATS System Administrator, Examiner, Auditor, or 

Disbursing View screen, click on the Help option.  A drop down list of additional options will 
appear. 

2. Click on the About IATS option.  The About IATS screen appears. 
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3. At the About IATS screen, click on the System Info link.  The MS Windows System screen will 
appear showing the System Information for your computer. 
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4. Click on the (X) in the top right corner when you are finished reviewing the System screen. 
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Locating the IATS Debug Log File 

On occasion, a representative from Professional Software Consortium (PSC), may assist an IATS user 
with a particular error with the IATS software.  Often times, the representative may need to review the 
IATS debug log file that resides on the users computer. 

A new feature was added to IATS that enables you to easily find the location where the IATS debug log 
file resides on your computer. 

Complete the following steps to "find" the location where the IATS debug log file resides: 

 

1. At the Menu bar at the top of the IATS System Administrator, Examiner, Auditor, or 
Disbursing View screen, click on the Help option.  A drop down list of additional options will 
appear. 

2. Click on the About IATS option.  The About IATS screen appears. 
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3. At the About IATS screen, click on the Log File link.  The File Explorer screen will appear 
showing the exact drive/directory where the IATS debug log file is residing.. 
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Checking the Status of your IATS License 

A valid and current license is required in order to use the IATS program.  This license is included with 
the IATS software but will expire after 60 days if the monthly per diem rates update provided by 
Professional Software Consortium (PSC) is not installed.   

A new feature was added to IATS that enables you to check the status of your IATS license to 
determine if the expiration date is near. 

Complete the following steps to "check" the status of your IATS license: 

 

1. At the Menu bar at the top of the IATS System Administrator, Examiner, Auditor, or 
Disbursing View screen, click on the Help option.  A drop down list of additional options will 
appear. 

2. Click on the About IATS option.  The About IATS screen appears. 
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3. At the About IATS screen, click on the License Info button.  The IATS Licenses display will 
appear. 
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4. Click on the OK button after you have finished reviewing your IATS license information. 
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Load License 

A valid and current license is required in order to use the IATS program.  This license is included with 
the IATS software but will expire after 60 days if the monthly per diem rates update provided by 
Professional Software Consortium (PSC) is not installed.   

In addition, a special license is needed to use some of the IATS features.  These features are typically 
specific to a particular IATS customer. 

A new feature was added to allow users to easily load a required license. 

 Complete the following steps to "load" an IATS license: 

 
1. At the Menu bar at the top of the IATS System Administrator, Examiner, Auditor, or 

Disbursing View screen, click on the Help option.  A drop down list of additional options will 
appear. 

2. Click on the About IATS option.  The About IATS screen appears. 
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3. At the About IATS screen, click on the Load License link.  The Open screen will appear. 
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4. At the Open screen, navigate to the drive/directory/folder where the license file is located. 
5. Click on the license file you wish to load. 
6. When the desired file is highlighted as shown above, click on the Open button. 

 

7. IATS displays a message pertaining to the status of the license as shown above. 
8. Click on OK to continue.  IATS loads the selected license. 
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Displaying your CAC Info 

On occasion, a representative from Professional Software Consortium (PSC), may assist an IATS user 
with determining what their CAC identification number is that is associated to their IATS user 
account.  This information is entered into IATS when their user account is created and is stored in the 
IATS database. 

A feature was added to IATS that allows a user to quickly and easily display their CAC information. 

Complete the following steps to "display" the System Information for your computer: 

 

1. At the Menu bar at the top of the IATS System Administrator, Examiner, Auditor, or 
Disbursing View screen, click on the Help option.  A drop down list of additional options will 
appear. 

2. Click on the About IATS option.  The About IATS screen appears. 
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3. At the About IATS screen, click on the CAC Info button.  An IATS Notification will appear 
displaying the user's CAC information. 
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4. When you are finished reviewing the CAC info, click on the OK button to continue. 
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Checking Inactivity for an IATS User 

An IATS user account will automatically be suspended after a particular number of days of inactivity, 
which is determined by the organization.   

A feature was added to IATS to allow the System Administrator to check the inactivity status of an IATS 
user. 

Complete the following steps to "check" the inactivity status of an IATS user: 

 

1. At the System Administrator View screen, click on the View option.  A drop down menu 
appears listing the various views the user has the privilege for. 

2. Click on the Maintenance option.  The Maintenance Main Menu screen will appear. 
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3. At the Maintenance Main Menu, click on the plus sign to the left of the item 
Configuration/Base Parameters. An expandable menu appears listing the various options. 

4. Click on the User Passwords and Privileges option. The Maintain User Passwords and 
Privileges screen appears. 
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5. Click on the desired user name from the list of IATS user accounts in the grid on the left side of 
the screen. 
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6. If you position your mouse pointer over the words User ID at the top of the screen, a pop-up 
message will appear showing how many days the selected user has been inactive. 

7. Notice at the bottom of the screen there is a statement indicating the number of days of 
inactivity that will cause the user account to become suspended. 
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Accessing the Maintenance Screen 

The IATS Maintenance Module is where IATS users must establish all of the configuration 
parameters for their particular customer type or branch of service.   

Access to the IATS Maintenance Module is only available from the System Administrator screen if the 
user has been granted the privilege to access Maintenance. 

Complete the following steps to "access" the IATS Maintenance Module: 

 

1. At the System Administrator View screen, click on the View option.  A drop down menu 
appears listing the various views the user has the privilege for. 

2. Click on the Maintenance option.  The Maintenance Main Menu screen will appear. 
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Changing Passwords 

Passwords should only be known by the individual user. After logging into IATS for the first time, you are 
required to change the System Administrator created password to a new password known only to the 
user. 

Password Requirements: 

 Passwords must be case sensitive 

 At least 8 characters must be changed to be valid 

 You cannot change your password to a password that was previously used during the last 12 
months or the last 10 passwords used 

 Passwords must be a minimum of a 15-character mix of upper case letters, lower case letters, 
numbers, and special characters (i. e. @, #,$,%,&,!). 

 A 15-character password consists of the following: 

 At least two lower case letters. 

 At least two upper case letters. 

 At least two numbers. 

 At least two special characters. 

In addition, the DoD requires you to change your logon password every 60 days. 

If you have logged into IATS and your logon password is expired, the following pop-up message 
appears: 

 

When this pop-up message is displayed, click on the OK button. The Change Passwords screen 
appears and you will then need to complete steps 3 - 7 below to change your passwords. 

Note: When changing your logon password, you must enter a new password that was different than the 
old one. 

Complete the following steps to "change" your passwords: 

Note:  An IATS user may only change their passwords once during a 24 hour period. 

1. Login to IATS. 
2. At the IATS for Windows screen, regardless of your view, click the Tools menu and then click 

on the Change Password option. The following screen appears: 



Introduction 

46 

 

At this screen, type the requested information and press the Enter or Tab key to continue. 

3. Old Password: Enter your current password. 
4. New Password: Enter your new password. 
5. Re-enter New Password: Re-enter the password you just entered at the New Password field to 

ensure accuracy. 
6. Repeat steps 3-6 above to change the Confirmation Password also, if desired. 
7. After entering the new password information, click the OK button to continue. 
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Change Offices 

IATS allows travel offices to combine multiple databases into one centralized database. This applies 
even if the configuration/customer type is different. For example, the original master database was Army, 
but DLA, Marines, and Navy, databases were merged into the original master database. 

If this situation occurs, users must have a way to switch between the different offices/configurations after 
logging into IATS. 

Note: In order to be able to perform this task, a user with the privilege to create/modify user passwords 
and privileges must access the maintenance module and specify which offices are active for a 
particular user. 

Complete the following steps to "change" your office: 
1. Login to IATS. 
2. At the IATS for Windows screen, regardless of your view, click the Tools menu and then click 

on the Change Office option. A sub-menu will appear listing the offices that are active for the 
particular user. 

 

3. Click on the desired office you wish to switch to. 
4. The Confirmation Password screen appears and you must enter your confirmation password 

and then click on OK. 
5. After you have switched offices, the office name you have switched to will now appear in the 

label at the top of the screen as shown below. 
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Navigation 

After a user logs-in to IATS, navigation through IATS is accomplished in a variety of ways: 

 Using a mouse: - Since IATS is a Windows® based program, a mouse is a common and 
frequently used device for navigating through IATS. Users may click on menu options, button 
options, selection lists, and input fields to make selections or access fields. 

 Using a Keyboard: - Every effort was made during the development of IATS to allow the user to 
press keys on the keyboard to navigate through IATS. 

 Arrow Keys: - When using the keyboard, the Up/Dn arrow keys may be used to navigate 
through menu options, drop down lists, and tables. 

 Hot Keys: - When using the keyboard, users will often see a letter underlined on a button or 
menu option. If you don't see any underlined letters, press the Alt key to make them 
appear.  When you see underlined letters, press and holds down the Alt key on the keyboard 
and then presses the letter that is underlined IATS performs the associated function. 

 Tab Key: - When using the keyboard, it is best to use the Tab key to navigate through the 
various input fields. Pressing the Tab key will usually take the user to the next input field. 
Depending on the screen, however, this may not always work. 

 Enter Key: - When using the keyboard, users may also press the Enter key to navigate through 
the various input fields. Pressing the Enter key will usually take the user to the next input field. 
Depending on the screen, however, this may not always work. 

 Space Bar: - When using the keyboard, certain input screens require the user to make 
selections to activate features or entitlements as depicted in the screen displayed below. 
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Rather than using the mouse to click in these boxes to activate the features, the user 
may simply press the space bar when the desired option is in focus. Being in focus 
means that a dotted line appears around the option as shown for the Liaison Reports 
option above. 

When making selections from listed items, the user may also use keyboard commands 
as follows: 

 Shift: - By using the Shift key on the keyboard, a user can select items listed 
consecutively by clicking on the first item, pressing and holding down the 
Shift key and then clicking on the last item. 

 Ctrl: - By using the Ctrl key on the keyboard, a user can select items randomly 
by clicking on the first item, pressing and holding down the Ctrl key and then 
clicking on the other desired items. 
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Menu Bar 

At the top of the Examiner, Auditor, Disbursing, or System Administrator screen, users will see a 
menu bar. The options available on the menu bar will vary depending on the users View and the 
privileges associated with their user account. 

 

If the user clicks on an item from the menu bar, a drop down menu appears displaying the available 
options. If there is a right arrow next to an option, an additional menu appears when the user points on 
the option and displays more options. 

Options are selected from the menu(s) two ways: 

 Click on an option using a mouse 

 Press the Up/Dn arrow keys on the keyboard to scroll through the menu. When the desired 
option is highlighted press the Enter key. 
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Button Options 

On every IATS screen, user will see a variety of buttons depending on the particular screen and the 
processes the user is performing, or has the privilege to perform. 

Notice that on every button, there is a letter that is underlined. 

This is a hot key that may be activated by using the keyboard. 

 

Button Options are selected two ways: 

 Click on a button using a mouse. 

 Press and hold down the Alt key on the keyboard and then press the letter that is underlined on 
the button. For example; pressing (Alt + G) will select the Grab Blocks option. 
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DTOD Mileage Look-up 

Note:  When the DTOD Lookup screen is displayed, you will notice in the title bar the version of the 
DTOD table IATS is using to pull the distance if the DTOD Web Service is being used.  Refer to Help 
topic "Maintaining DTOD Web Service Versions" if you wish to change the version/effective date. 

When processing a request for settlement, it may be necessary to look-up the authorized mileage for the 
official distance in the DTOD mileage table. 

This can be accomplished two (2) ways. 

Method 1: 

1. By clicking the Tools menu at the top of the Examiner, Auditor, Disbursing, or System 
Administrator View screen. A drop-down menu appears displaying the available options. 

 
2. From the drop-down menu, click on the DTOD option. IATS will then display the DTOD Lookup 

screen. 
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Method 2: 

1. When processing a request for settlement, click on the Other button if it appears on the screen. 
A sub-menu appears displaying the available options. 

 
2. From the sub-menu, click on the DTOD option. IATS will then display the DTOD Lookup screen. 
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Refer to the Help topic, "Completing the Query DTOD Screen", for detailed instructions on using this 
screen. 
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Completing the Query DTOD Screen 

Note:  When the DTOD Lookup screen is displayed, you will notice in the title bar the version of the 
DTOD table IATS is using to pull the distance if the DTOD Web Service is being used.  Refer to Help 
topic "Maintaining DTOD Web Service Versions" if you wish to change the version/effective date. 

When processing a request for settlement, it may be necessary to look-up the authorized mileage for the 
official distance in the DTOD mileage table. 

This can be accomplished by using the DTOD Lookup screen. 

Complete the following steps to "complete" the DTOD Lookup screen: 

1. Access the DTOD Lookup screen by using one of the methods demonstrated in the Help topic 
"DTOD Mileage Look-up". 

 

2. At the top of the DTOD Lookup screen, you will see a check box next to the words "Travel is in 
the DTOD's North American region". If not already checked, click in the check box to activate 
it if the mileage you wish to look-up is in the North American region. 

3. Effective Date: - The current date will default to the Effective Date field.  Enter a new date in 
MMDDYY format or click on the down arrow button to use the calendar if you wish to change 
this date. 

4. Select Arrival Location: - Enter the Zip Code or the name of the arrival city and then click on 
the Search button. 
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5. Click on the down arrow button if needed to display a list of city names matching the city name 
you entered. 

6. Click on the desired location from the drop down list of city names to make your selection. 
7. Select Departure Location: - Enter the Zip Code or the name of the departure city and then 

click on the Search button. 

 

8. Click on the down arrow button if needed to display a list of city names matching the Zip Code 
or city name you entered. 

9. Click on the desired location from the drop down list of city names to make your selection. 
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10. Travel Distance: - After selecting the arrival and departure locations, click on the Lookup button 
at the Travel Distance field. IATS will look-up the mileage and display it in the Travel Distance 
field. 

 

11. When finished using the DTOD Lookup screen, click the OK button. 
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View Travel History 

The Travel Order History screen is used to provide users with an easy to read inquiry screen, and 
includes all necessary travel data elements stored in the travel account database. 

Tip: The Travel Order History screen can be accessed from the Examiner, Auditor, Disbursing, or 
System Administrator View screen, or by clicking on the Other button when processing a Request for 
Advance, or Settlement. Please refer to the instructions below to access the Travel Order History 
through either method. 

Complete the following steps to "view" a traveler's historical record: 
1. At the Examiner, Auditor, Disbursing, or System Administrator View screen, click on the 

Tools menu. A drop down menu appears listing various options. 
2. Click on the History option. The Select Traveler screen appears. 
3. At either the Select Traveler screen, there are (2) methods for selecting a traveler account: 

 Method 1: - At the Search By field, click in the appropriate radio button to select your search 
by either SSN or DoD ID.  After making your selection, enter either the traveler's SSN or DoD ID 
at the corresponding input field and then press Tab. 

 Method 2: - Type the first (2) letters of the traveler's last name. A listing appears displaying all 
travel accounts in the IATS database beginning with these (2) letters. Click on the Up/Down 
arrows next to this listing or press the Up/Down arrow keys on the keyboard to scroll through 
the list.  When the desired traveler is highlighted, click on the highlighted name. 

4. After selecting a travel account, the Travel Order History screen appears. 

 

Note: This screen is divided into (2) sections; Travel Orders and Travel Order Details. The Travel 
Order section, lists every travel order existing in the IATS database for the selected traveler. The 
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Travel Order Details sections, lists every transaction existing in the IATS database for the travel order 
number highlighted above in the Travel Order section. 

5. At the Travel Order History screen, travel orders can be displayed by the following methods: 

 Method 1: - Double click on an order number listed in the Travel Order section. 

 Method 2: - Click on an order number listed in the Travel Order section and then click on the 
Display button. 

 Method 3: - Type the desired order number at the Order Number field and then click on the 
Display button. 

6. After using one of the methods above, the Travel Order screen appears for the selected travel 
order. 

 

Tip: At this screen, the user may click on each tab to review the specific details pertaining to the travel 
order. 

7. When finished reviewing the Travel Order screen, click on the Done button. IATS returns to 
the Travel Order History screen. 

Complete the following steps to "view" travel order details: 

1. Click on a transaction listed in the Travel Order Details section and then click on the Display 
button. The Travel Order Detail screen appears for the selected transaction. 
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Tip: At this screen, the user may click on each tab to review the specific details pertaining to the 
transaction. Different tabs will be available depending on the type of travel order selected. In addition, if 
the Request button is visible at the bottom left corner of the Travel Order Detail screen, you may click 
on this button to display the input screens for the selected request. 

2. When finished reviewing the Travel Order Detail screen, click on the Exit button. IATS returns 
to the Travel Order History screen. 

Complete the following steps to "view" a travel history record from the Advance or Settlement 
Request screen: 

1. At the Advance or Settlement Request screen, click on the Other button. A sub-menu appears 
listing various options. 



Introduction 

62 

 

2. Click on the History option. The Travel Order History screen appears. 
3. From this point, follow the instructions provided in the first section above to continue viewing 

the Travel Order History screen. 
4. When finished viewing the Travel Order History screen, click on the Exit button. The Select 

Traveler screen appears allowing you to make a selection and view the history for a different 
person, if desired. 

5. If you do not want to view the history for another individual, click on the Cancel button to return 
to the Advance or Settlement Request screen. 
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View Travel History by Order 

The Travel Order History screen is used to provide users with an easy to read inquiry screen, and 
includes all necessary travel data elements stored in the travel account database. 

A new feature was added to IATS that allows the user to look-up a traveler's History record by just 
entering a travel order number. 

Complete the following steps to "view" a traveler's historical record: 

 

1. At the Examiner, Auditor, Disbursing, or System Administrator View screen, click on the 
Tools menu. A drop down menu appears listing various options. 

2. Click on the History By Order option. The Select Order By Travel Order Number screen 
appears. 
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3. At the Select Order By Travel Order Number screen, enter the order number at the Travel 
Order Number field and then press the Tab key. 

4. If the order number exists, the traveler's name and traveler order information will appear. 
5. Traveler:  At the Traveler field, you can click on the down arrow button.  IATS will list the 

names of any other travelers with the same Travel Order Number.  Click on the correct traveler 
name to make your selection if applicable. 

6. If this is the correct order number and traveler, click on the OK button.  The Travel Order 
History screen will appear. 
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Refer to the Help topic, "View Travel History", for additional instructions on how to view a traveler's 
History. 
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View Travel History by DOV Number 

The Travel Order History screen is used to provide users with an easy to read inquiry screen, and 
includes all necessary travel data elements stored in the travel account database. 

A feature was added to IATS that allows the user to look-up a traveler's History record by just entering a 
DOV number. 

Complete the following steps to "view" a traveler's historical record: 

 

1. At the Examiner, Auditor, Disbursing, or System Administrator View screen, click on the 
Tools menu.  A drop down menu appears listing various options. 

2. Click on the History By DOV option.  The Select Traveler / Order by DOV screen appears. 
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3. At the Select Traveler / Order by DOV screen, enter the DOV number at the Select DOV field. 
4. Click on the Search button.  The Select Traveler / Order by DOV screen will re-appear listing all 

payments associated to the DOV number you entered. 



Introduction 

68 

 

5. Click on the payment you wish to display the history for. 
6. When you have selected the desired payment, click on the OK button.  The Travel Order 

History screen will appear. 
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Refer to the Help topic, "View Travel History", for additional instructions on how to view a traveler's 
History. 
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Display Rates 

While using IATS, the user may find it necessary to look-up a rate on occasion. The Display Rates 
screen provides the user with an easy way to look up various rates that will assist in processing the 
various travel transactions or answering inquiries. 

Complete the following steps to "display" rates: 

1. Access the Display Rates screen through one of the following methods: 

 Method 1: - Click on the Tools menu and then select the Rates option. 

 Method 2: - Click on the Other button and select the Rates option. 

 Method 3: - Click on the Lookup button and select the Rates option. 

After using one of the (3) methods listed above, the Display Rates screen appears. 

 

2. At this screen, the various rates tables in the IATS Maintenance module are listed. 
3. Double click on one of the listed tables or click on a item and then click the Display button. 

IATS displays the screen for the selected rates table. 
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4. After reviewing the selected rates screen, click the Cancel button to close the screen. 
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Using the View Locality Rates - Screen 

The View Locality Rates screen provides the user with an alternative way to look up various rates that 
assists in processing the various travel transactions or answering inquiries. 

Complete the following steps to "display and use" the View Locality Rates screen: 

1. Access the Display Rates screen through one of the following methods: 

 Method 1: - Click on the Tools menu and then select the Rates option. 

 Method 2: - Click on the Other button and select the Rates option. 

 Method 3: - Click on the Lookup button and select the Rates option. 

After using one of the (3) methods listed above, the Display Rates screen appears. 

 

2. At this screen, the various rates tables in the IATS Maintenance module are listed. 

3. Double click on View All Rates option or click on the View All Rates option and then click the 
Display button.  IATS will display the View Locality Rates screen. 
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Note:  You can also access the View Locality Rates screen from the Maintenance Main Menu by using 
the following steps:  At the Maintenance Main Menu, click on the plus sign next to the word Locality 
Data and then click on the View All Rates option. 

 

4. Select Country/State: - At the View Locality Rates screen you must first select a country or 
state you wish to display the rates for.   

5. Click on the down arrow button at the Select Country/State field.  IATS will display an 
alphabetical listing of countries and states. 

6. Press the Up/Dn arrow keys on your keyboard or click on the Up/Dn arrow buttons on the 
slider bar on the right side of the listing to scroll through the list. 

7. Click on the desired country or state name and then press Tab to display the associated 
rates.  IATS will display a list of cities for the selected country or state. 

 

Using the Filter Row: 
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1. You will notice a blank line just under the column headings on the grid.  This is a Filter Row 
as shown above. 

2. In the example below, (mo) was entered into the Filter Row in the City column.  Notice that every 
name displayed in the City column begins the letters (mo). 

3. You may filter every column using this same technic except for the Zipcode column where you 
must enter numbers instead of alpha characters. 

4. When you are finished filtering the display, click on the Clear Filter button to return to the 
original/default display. 

 

Display the location on a Google map: 

 

1. Click on a city name you wish to view on the Google map. 
2. When the desired city name is highlighted, right click on the highlighted name with your 

mouse.  The Google Map screen will appear showing the selected location. 
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3. When you are finished reviewing the map close the page to return to the View Locality Rates 
screen. 

Display the Locality Rates 

 

1. Click on a city name you wish to display the rates for. 
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2. When the desired city name is highlighted, right click on the highlighted name in the M&IE 
Locality column with your mouse.  The Maintain Locality Rates screen will appear showing the 
rates for the selected location. 

 

3. When you are finished reviewing the rates click on OK to close the screen and return to the 
View Locality Rates screen. 

Display the ILP Rates 
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1. Click on a city name you wish to display the rates for. 
2. When the desired city name is highlighted, right click on the highlighted name in the ILP 

Locality column with your mouse.  The Maintain ILP Rates screen will appear showing the rates 
for the selected location. 
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3. When you are finished reviewing the rates click on OK to close the screen and return to the 
View Locality Rates screen. 

4. When you are finished using the View Locality Rates screen, click on the Exit button to close 
the screen. 
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Sorting Blocks or Claims 

When performing various functions using IATS, there are screens that appear displaying a list of blocks 
or a list of claims. These lists may be sorted by clicking on the column headers. 

Notice that there are several column headers displayed on the screen below. 

 

Click on any column header and the information listed will be sorted. 

For example, notice that the Type column list shows both Settlement and Advance blocks. 

If you click on the Type header, you will see that the column is now sorted by type. The Advance blocks 
will be listed before the Settlement blocks as shown below. 
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Click the header again and the column will be sorted in reverse order. 
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Using the IATS Report Viewer 

For some of the IATS reports, the IATS Report Viewer screen will appear when you have selected the 
option to print the report. 

Notice that there is a tool bar along the top of the screen that gives you a variety of options when using 
this screen. 

Complete the following steps to "use" the IATS Report Viewer: 

 

1. Page Numbers: - If the report you have generated contains more than one page you can click 
on the left and right arrow buttons to scroll to the different pages. 

2. Printer: - Click on the Print button to print the report. a Print screen will appear allowing you to 
select the desired printer and the number of copies. 

3. Print Layout: - Click on the Print Layout button to adjust the layout of the print job.   
4. Page Setup:  Click on the Page Setup button to adjust the paper size, the paper source an 

the orientation of the page 
5. Export: - Click on the Export button if you wish to save the report to a file.  Clicking on this 

button will display a drop down menu giving you the options to save the report in an Excel, PDF 
or Word format. 
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WinIATS Help 

Using On-line Help 

A Help System has been included with the IATS program that provides explanations for the numerous 
program features. In addition, users will find detailed instructions that will guide them through the 
various functions involved in processing travel claims. 

The IATS Help System can be accessed from any screen by clicking on the Help menu or Help button. 

 

After clicking on the Help menu, a drop down menu appears listing the following Help options: 

 Contents: - Select this option to see a display of the available topic categories. 

 Index: - Select this option to see an alphabetical listing of IATS Help topics. 

 Search: - Select this option, type a keyword into the dialog box, and then click on the List 
Topics button. A list of every topic containing the keyword is displayed. 

 This Screen: - Select this option to see a Help topic for the particular IATS screen that is 
currently displayed. 

 About IATS: - Select this option to see a Help topic describing the IATS program. 

Tips for using the IATS on-line Help system: 

When a Help window is open, the following options are available: 

 Users can maximize or re-size help windows as needed. 

 Click on the Print button to receive a print-out of the topic. 

 Click on the Forward button to advance to the next topic in the browse sequence, or the Back 
button to return to the previous topic. 

 Click on any word or phrase that is underlined and highlighted in blue to automatically jump to 
a topic that describes the underlined item. 
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 Click on a link from the menu displayed by the See Also button to jump from one topic to 
another related topic. 

 After clicking on a link from the menu displayed from the See Also button, click the Back button 
to return to the previous topic. 

Topics in the IATS Help system are categorized into Books. Help Contents Books are displayed two 
ways: 

1. Click the Help menu at the top of any screen and then click on the Contents option. 
2. Click on the Contents tab at the IATS Help Topics screen. 

Click on the See Also button below and select the topic that provides detailed instructions for using 
the IATS on-line Help program. 
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Using On-line Help 

A Help System has been included with the IATS program that provides explanations for the numerous 
program features. In addition, users will find detailed instructions that will guide them through the 
various functions involved in processing travel claims. 

The IATS Help System can be accessed from any screen by clicking on the Help menu or Help button. 

 

After clicking on the Help menu, a drop down menu appears listing the following Help options: 

 Contents: - Select this option to see a display of the available topic categories. 

 Index: - Select this option to see an alphabetical listing of IATS Help topics. 

 Search: - Select this option, type a keyword into the dialog box, and then click on the List 
Topics button. A list of every topic containing the keyword is displayed. 

 This Screen: - Select this option to see a Help topic for the particular IATS screen that is 
currently displayed. 

 About IATS: - Select this option to see a Help topic describing the IATS program. 

Tips for using the IATS on-line Help system: 

When a Help window is open, the following options are available: 

 Users can maximize or re-size help windows as needed. 

 Click on the Print button to receive a print-out of the topic. 

 Click on the Forward button to advance to the next topic in the browse sequence, or the Back 
button to return to the previous topic. 

 Click on any word or phrase that is underlined and highlighted in blue to automatically jump to 
a topic that describes the underlined item. 

 Click on a link from the menu displayed by the See Also button to jump from one topic to 
another related topic. 
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 After clicking on a link from the menu displayed from the See Also button, click the Back button 
to return to the previous topic. 

Topics in the IATS Help system are categorized into Books. Help Contents Books are displayed two 
ways: 

1. Click the Help menu at the top of any screen and then click on the Contents option. 
2. Click on the Contents tab at the IATS Help Topics screen. 

Click on the See Also button below and select the topic that provides detailed instructions for using 
the IATS on-line Help program. 
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Displaying Help Topics 

Topics in the IATS Help system are categorized into Books. 

 

Complete the following steps to "display" a Help topic: 

1. Double click on a Book. The Help system will then display Help topics contained within the 
selected Book as shown above. 

2. Click on any of the listed Help topics displayed after opening the book. IATS displays the 
contents of the topic as shown above. 

Click on the See Also button below and select the topic that provides detailed instructions for using 
the IATS on-line Help program. 

  



IATS 8.7.3 User Guide 

87 

Searching for Help Topics 

The IATS on-line Help program includes a feature that allows the user to type a keyword to search for 
topics containing the keyword entered. 

Complete the following steps to "search" for Help topics: 

1. At the IATS Help screen, click on the Search tab. A dialog box opens. 
2. At the dialog box, type the desired keyword and then click on the List Topics button. A list of 

every topic containing the keyword is displayed. 

 

Note: In the example screen above, the word delete was entered at the dialog box. After clicking on the 
List Topics button, every Help topic containing the word delete was displayed. 

3. When the topics list is displayed, double click on any topic to display the contents of that 
topic. The keyword will be highlighted when the contents of the topic is displayed. 

Click on the See Also button below and select the topic that provides detailed instructions for using 
the IATS on-line Help program. 
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Views 

About Views 

The Integrated Automated Travel System (IATS) is operated in five different View modes, which 
determine what functions the user may perform. View modes are established by the System 
Administrator when user accounts are created or modified in the Maintenance module. When user 
accounts are created or modified, the System Administrator initiates the user account to operate in one 
of the following Views: 

Examiner, Auditor, Disbursing, System Administrator, and Super User. 

Note: Click on any of the links listed below for addition information. 

Examiner Functions 

Auditor Functions 

Disbursing Functions 

System Administrator Functions 

Super User Functions 
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About Views 

The Integrated Automated Travel System (IATS) is operated in five different View modes, which 
determine what functions the user may perform. View modes are established by the System 
Administrator when user accounts are created or modified in the Maintenance module. When user 
accounts are created or modified, the System Administrator initiates the user account to operate in one 
of the following Views: 

Examiner, Auditor, Disbursing, System Administrator, and Super User. 

Note: Click on any of the links listed below for addition information. 

Examiner Functions 

Auditor Functions 

Disbursing Functions 

System Administrator Functions 

Super User Functions 
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Changing Views 

An IATS user with Super User capabilities has the option to change their View mode. After logging into 
IATS, the View menu is displayed at the menu bar at the top of the System Administrator View screen. 
Click on the View menu and a drop down list of View Modes is displayed. 

 

Click on one of the listed options or press the Up/Down arrows to highlight an option and press Enter 
to make a selection. 

After making a selection, the Title bar of the screen changes to indicate the selected View mode. 

Note: Click on any of the links listed below for additional information. 

Examiner Functions 

Auditor Functions 

Disbursing Functions 

System Administrator Functions 

Super User Functions 
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Examiner Functions 

An Examiner is the individual primarily responsible for the overall processing of travel payments.  When 
logged into IATS in the Examiner View mode, a user may log incoming claims, process advances and 
settlements, post accrued per diem payments, and process collections. 

In addition, examiners may have the capability to create traveler accounts and create travel order 
records. 

These functions, however, are dependent upon the privileges that have been established for the user 
by the System Administrator. 
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Auditor Functions 

An Auditor is an IATS user, who has been assigned this function and associated privileges by the 

System Administrator when the user account was created. 

IATS flags certain claims for audit based on several criteria that may be established by the System 

Administrator in accordance with office or regulatory requirements. 

An audit is mandatory for any travel claim that has been flagged by IATS for an audit. 

An Auditor is the individual responsible for reviewing travel claims that have been processed by an 

Examiner and are flagged for audit. 

When a claim has been flagged by IATS for audit, an individual with Auditor Function capabilities must 

access the flagged block and either review the flagged claim on-screen, or review a printed audit report. 

The way an audit is performed is dependent upon how IATS is configured for the particular travel office. 

If IATS is configured for mandatory audit, the Auditor must review every input screen for a claim flagged 

for audit. 

Note: When a claim is flagged for audit, the entire block of claims is flagged and can only be released 
for further processing by an individual with Auditor Function capabilities. 

Once the auditor has reviewed the flagged claims, it may be necessary for the Auditor to return the 
block to the Examiner to make corrections. 

When the auditor is satisfied that all flagged claims on a block are correct and ready for payment, the 
Auditor must release the block for further processing. 
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Disbursing Functions 

A Disbursing clerk is an IATS user, who has been assigned this function and associated privileges by 
the System Administrator when the user account was created. 

An individual with Disbursing capabilities is responsible for preparing a block of processed claims for 
payment. 

In addition, this individual must release the processed blocks to the Disbursing module and perform the 
following functions depending on the way IATS is configured for the particular travel office: 

 Assign Disbursing Office Voucher (DOV) numbers 

 Generate Disbursing Reports 
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System Administrator Functions 

A System Administrator is an IATS user, who has been assigned this function and associated privileges 
when the user account was created. 

The System Administrator is the individual responsible for the overall operation of IATS and controlling 
the work flow throughout the system. System Administrators are responsible for the set-up and 
configuration of IATS for the particular travel office. In addition, System Administrators perform the 
following additional functions: 

 Performing system maintenance 

 Establishing user accounts 

 Unlocking locked accounts and records 

 Assigning/re-assigning blocks and claims 

 Deleting completed blocks 

 Deleting unneeded traveler or travel order details 

 Debt management 

 Importing and updating system rates files 

 Processing interfaces between accounting, disbursing, and personnel systems 

 Generating management reports 

 Running utility programs 
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Super User Functions 

When user accounts are created by the System Administrator, a View mode must be established. The 
functions a user may perform are dependent upon the View mode associated with their user ID. 

Because some travel offices are small and may be operated by only one individual, however, IATS 
includes a Super User View mode. 

The Super User View allows the user to switch between various View modes without logging out and 
logging back in with a different user ID. 

When the Super User logs-in initially, their View mode defaults to System Administrator. A Super User 
may access the View menu, however, and change the View to Examiner, Auditor, Disbursing, or 
Maintenance functions as desired. 

Note: Although, the title of this particular View is Super User, this does not mean that a user under this 
View has the ability to perform any desired function. All privileges for every View are established in the 
Maintenance module by the System Administrator and may be restricted as needed. The Super User 
View is unique, however, because a Super User has the ability to change View modes, without having 
to log out and then log back in with a different password in order to perform a different function. 
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Accessing the Maintenance Screen 

The IATS Maintenance Module is where IATS users must establish all of the configuration 
parameters for their particular customer type or branch of service.   

Access to the IATS Maintenance Module is only available from the System Administrator screen if the 
user has been granted the privilege to access Maintenance. 

Complete the following steps to "access" the IATS Maintenance Module: 

 

1. At the System Administrator View screen, click on the View option.  A drop down menu 
appears listing the various views the user has the privilege for. 

2. Click on the Maintenance option.  The Maintenance Main Menu screen will appear. 
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Travel Accounts 

About Traveler Profile 

A Traveler Profile is an account that must be created for every individual who's travel advance or 
settlement is processed through IATS. This profile is used to store personal information about the 
traveler and is automatically transferred to transactions processed for the traveler. 
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Creating Traveler Profile 

Note: A traveler profile may be created by an IATS user in the Examiner or System Administrator view 
if the privilege was established when the IATS user account was created. 

Complete the following steps to "create" a Traveler Profile: 
1. Login to IATS as an Examiner or System Administrator, and click on the Tools menu at the 

top of the IATS for Windows screen. A drop down list of options appears. 

 
2. Click on the Traveler Profile option and the Select Traveler screen appears. 

 

3. At the Select Traveler screen, click in the appropriate radio button to select your search by 
either SSN or DoD ID..  

4. After making your selection, enter either the traveler's SSN or DoD ID at the corresponding input 
field and then press Tab.   

5. The following message appears indicating that the account does not exist: 
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6. Click the OK button to continue. The Verify New Traveler SSN screen appears. 

 
7. Re-enter the traveler's SSN at the Verify SSN field and then click on OK. 

8. After clicking on OK, the Traveler Profile screen appears. 

The following links provide detailed instructions for completing the Traveler Profile screen. 

Enter Personal Information 

Enter Financial Information 

Enter Foreign Bank Information 

Enter Mailing Address Information 

Enter Office Address Information 

Enter E-mail Address Information 

Enter Miscellaneous Information 
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Entering Traveler's Personal Information 

The travel account personal information is used to identify the traveler's grade/rank, organization, 
credit card status, etc. 

Complete the following input fields, in the screen shown below, to "enter" a traveler's personal 
information: 

 

DoD ID: - When this feature is activated in Maintenance, you must enter a 10 digit DoD ID number. 

Name: - There are two methods for entering the traveler's name: 

 Method 1: - Enter the last name in the Last Name field, and press Tab. The cursor moves to the 
next field and prompts for entry of the traveler's First Name. Type the first name, and press Tab. 
The cursor advances, and prompts for the Middle Initial. Type the traveler's middle initial (if 
applicable) and press Tab. 

 Method 2: - For example; if John S. Doe is the name you wish to enter, type: Doe, John, S at 
the Last Name field. Press Tab and the name automatically separates into the three input fields. 
When entering a suffix, such as, Jr., Sr., III, etc., enter the suffix following the last name. For 
example; input John E. Brown Jr.: [BROWN JR., JOHN E]. 

Employee Status: - Press the Down arrow button on your keyboard to scroll through the options or click 
on the Down arrow button. A listing appears offering several employee categories. Click on the desired 
choice or press the Up/Down arrow keys. When the correct choice is highlighted, press Tab. 

Grade/Rank: - When Employee (Civilian), or Member (Uniform Services) is selected for the Employee 
Status, a list appears displaying the legal field entries. Press the Down arrow key on your keyboard to 
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scroll through the options or click on the Up/Down arrow buttons. When the correct choice is highlighted, 
press Tab. 

Salutation: - This is an optional field, but does provide the salutation for the letters generated by IATS, 
which are mailed to the traveler. Examples are: Mr., Mrs., SGT, LtCdr, etc. To bypass, press Tab. 

Position/Title: - This is an optional field. Type the desired information or press Tab to bypass this field. 

Security Clearance: - Press the Down arrow on your keyboard to scroll through the options or click on 
the Down arrow button. A listing appears offering several choices. Click on the desired choice or press 
the Up/Down arrow keys. When the correct choice is highlighted, press Tab. 

DSSN: - The default number displayed is from the DSSN field at the Base Description screen in the 
Maintenance module. This number is used to identify the office disbursing the payment. No input should 
be needed. 

Credit Card Status: - Press the Down arrow on your keyboard to scroll through the options or click on 
the Down arrow button. A listing appears offering several choices. Click on the desired choice or press 
the Up/Down arrow keys. When the correct choice is highlighted, press Tab. 

Govt Credit Card Nbr: - If the Credit Card Status is Holder of Govt. Credit Card, enter the government 
issued credit card number and then press Tab to continue. 

Service: - The default value at this field will match the Customer IATS was configured for when the initial 
maintenance was performed. No input should be needed. 

Organization: - This is a required input field. Type the name or abbreviation for the organization the 
traveler is assigned to. For example, [DFAS-IN] or [B CO., 1/9 INF] and press Tab. 

Automatic Audit: - When this feature is activated, IATS will flag every settlement, processed for this 
traveler, for audit. To activate this option, click in the check box next to the phrase "Automatically audit 
all claims for individual". 

VIP Traveler: - When this feature is activated, the traveler and trip information will appear in red when 
a claim is logged to a block indicating that the traveler has VIP status. To activate this option, click in the 
check box next to the phrase "This traveler has VIP status". 

Freeze Traveler: - When this feature is activated, the traveler account cannot be used.  This feature was 
added for situations where the traveler account was created incorrectly and claims have been 
processed.  By using this feature you may keep the historical data for the claim, (unless the account was 
deleted), but prevent users from accessing the incorrectly created account again.  Note that this feature 
is only visible when you access the traveler's profile from the System Administrator View screen. 

Traveler is non-taxable (Foreign National): - Click in the check box to activate this option if the 
traveler is a foreign national and taxes should not be withheld from payments. 

Profile Flagged: - Click in the check box to activate this option if you wish to flag the traveler's account 
for review. 

Traveler is a Legal (Bona Fide) Resident of Puerto Rico: - Click in the check box to activate this 
option if applicable. 

Turn Off Hardcopy Tax Statements: - By default, this option is set to On.  This option can only be set to 
Off by the traveler via their myPay account.  IATS will import files from the myPay system that will reset 
the flag to Off if the traveler makes that change to their myPay account.  See the Note below. 

Note:  IATS Users with Role designation of Tax Accountant or the System Administrator or Super 
User View can reset the Turn Off Hardcopy Tax Statements flag to On if it has been set to Off via a 
myPay import file.  The IATS users can only make this change if the privilege "Turn On Hardcopy Tax 
Statements" granted to their user account. 

Remarks: - When Profile Flagged is checked, a Remarks text box appears.  Use this text box to enter 
a reason for flagging the traveler's profile for review. 
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Click on the Financial or Address/Contact Information tab or click the Next button to continue. 
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Entering Traveler's Financial Information 

The travel account financial information is used to identify the traveler's EFT status and establish the 
bank routing and account numbers that are used for direct deposit payments. 

Complete the following input fields, in the screen shown below, to "enter" a traveler's financial 
information: 

 
1. First you would click on the Financial tab to bring it into focus. 
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2. EFT Status: - Press the Down arrow on your keyboard to scroll through the options or click on 

the Down arrow button. A listing appears offering three choices. Click on the desired choice or 
press the Up/Down arrow keys. When the correct choice is highlighted, press Tab. 

Note: After clicking on the Down arrow, if you are unable to make a selection form the drop-down listing 
at the EFT Status field, you do not have the privilege to create or modify the traveler's financial 
information. A supervisor or IATS user with access to the Maintenance Module would have to grant the 
privilege "Create/Modify Financial Information". 

3. EFT to be Updated by: - Press the Down arrow on your keyboard to scroll through the options or 
click on the Down arrow button. A listing appears offering two choices. Click on the desired 
choice or press the Up/Down arrow keys. When the correct choice is highlighted, press Tab. 

Note: The two types are either IATS, (when the EFT account data was manually entered), or Payroll, 
(when the EFT account data was entered though the payroll interface process). 

Tip: The EFT to be Updated by option must be set to IATS for travelers, who desire a different EFT 
account for their travel pay instead of the account for their salary deposit. Otherwise, their EFT account 
information will be overlaid with the information on the Payroll file the next time this file is processed. 

4. Account Type: - Press the Down arrow on your keyboard to scroll through the options or click 
on the Down arrow button. A listing appears offering several choices. Click on the desired choice 
or press the Up/Down arrow keys. When the correct choice is highlighted, press Tab. 

5. Routing Number: - The selection of Active in the EFT Status field requires entry of the (9) digit 
Bank Routing Code (which includes a one character check digit). IATS will calculate this check 
digit for accuracy. If the wrong check digit is entered, IATS will not accept the Bank Routing 
Code. After typing the routing number press Tab to continue. 
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6. If the routing number entered does not match a number in the routing number table in the IATS 
database, the following pop-up message appears: 

 
7. Click on Yes or No as applicable. 
8. After clicking on Yes, the Verify Bank Routing Number screen appears. 

 

9. Re-enter the bank routing number at the Verify field and then click on OK. 
10. Account Number: - If Active was selected at the EFT Status field, type the account number for 

the deposit of the EFT payment.  After typing the account number press Tab to continue.  The 
Verify Bank Account Number screen appears. 
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11. Re-enter the previously entered account number at the Verify field and then click on OK. 
12. Date Last Checked: - This field is optional.  If required to be entered by your travel office policy, 

however, click in this field and enter the date that the traveler's EFT account information was 
last verified in MMDDYY format.  You can also click on the down arrow button and use the 
calendar to select the date. 

Note:  After the traveler's EFT account information has been entered and saved, the fields "Date Last 
Changed", "Date Last Checked", and "Changed by" will reflect the date the EFT information was 
created/changed and show the initials of the person that created/changed the EFT information.  The 
"Date Last Downloaded" field will reflect that date that the information was changed by a payroll 
download file. 

 

13. Foreign Bank: - Click in the check box to activate this option if the traveler wishes to have their 
EFT payment sent to a foreign bank account.  If this option is checked and the traveler already 
had domestic bank account information established for their EFT payments, IATS will display 
the following pop-up message. 

 

14. Click on Yes or No as desired.  If you click on No, IATS will display the following pop-up 
message. 
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15. Click on OK to continue. 

Foreign Bank Information: 

When the Foreign Bank option is checked, IATS will display the following input fields as shown below: 

 

Refer to the Help topic, "Entering Foreign Bank Information", for additional instructions. 
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Entering Foreign Bank Information 

The travel account financial information is used to identify the traveler's EFT status and establish the 
bank routing and account numbers that are used for direct deposit payments. 

 Complete the following input fields, in the screen shown below, to "enter" a traveler's foreign 
bank information: 

When the Foreign Bank option is checked on the Financial tab, IATS will display the following input 
fields as shown below: 

 

1. Foreign EFT Status: - Click on the down arrow button.  A listing appears offering three 
choices.  Click on the desired choice to make your selection. 

2. Account Type: - Click on the down arrow button.  A listing appears offering several choices. 
Click on the desired choice to make your selection. 

3. Currency for Payment:  The default value will be Us Dollar (USD).  If another type is desired, 
click on the down arrow button to display a list of currency types and then click on your desired 
type. 

4. SWIFT Code / Sort Code: - The default value at this field is SWIFT Code.  Click on the down 
arrow button to display the drop-down list and click on Sort Code if you wish to change the 
Foreign EFT Type.  After entering either a SWIFT Code or a Sort Code, a pop-up message will 
appear requiring you to re-enter and verify the code you entered. 
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5. Re-enter the code and click on OK to continue. 
6. IBAN Account Number: - Click in this field and enter the foreign bank account number.  After 

entering the IBAN, a pop-up message will appear requiring you to re-enter and verify the IBAN 
you entered.   

Note:  The following information is applicable to IBAN Account Numbers: 

 IBANs have a unique length depending on the country and they must begin with the country 
code. 

 There are tables in the IATS Maintenance module, (maintained by the System Administrator), 
that specify what the length of the IBAN codes are by country. 

 The characters must be alphanumeric, (letters and numbers) only. 

 Must start with a valid 2-character ISO country code. 

 There are some countries that do not use IBAN codes, but there is a customer requirement to 
store EFT information for these countries.  These are referred to as non-IBAN participating 
countries. 

 Non-IBAN participating countries will have an IBAN length of 99. 

 For IBAN length of 99, the IBAN can be anywhere from 2 to 35 letters/digits long.  

 The EFT information for countries that have an IBAN legnth of 99 cannot be used for 
disbursing and the EFT profile will be saved as Inactive. 
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7. Date Last Checked: - This field is optional.  If required to be entered by your travel office policy, 
however, click in this field and enter the date that the traveler's EFT account information was 
last verified in MMDDYY format.  You can also click on the down arrow button and use the 
calendar to select the date. 
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Entering Mailing Address Information 

The traveler's mailing address information is used to populate printed vouchers, letters, and upload 
records, generated by IATS, with the address where the traveler receives mail. 

Complete the following input fields, in the screen shown below, to "enter" a traveler's 
Address/Contact information: 

 

Tip: After making the required entries on at Personal tab, click on the Address/Contact Information 
tab to display the Mailing Address, Office Address, and E-mail Address sections. 

Address-1: - This is a required field. Type the first line of the traveler's mailing address and press Tab. 

Address-2: - This field is optional, and is used to add an Apt. #, P.O. Box, etc. Type the desired entry, if 
applicable, and press Tab. 

City: - A required field. Type the name of the city where the traveler receives mail. Type APO or FPO on 
this line if the traveler has an overseas military mailing address. 

State/Country: - A required field. For CONUS locations, type the two letter state code. If unknown, enter 
the letter the state begins with, then click on the Up/Down arrow keys until the desired state is 
highlighted. Press Tab or click on the highlighted item. For an OCONUS location, type the first letter of 
the country code. If the desired country is not highlighted, click on the Up/Down arrows to highlight the 
desired locality code. Press Tab or click on the highlighted item. Press Tab, to move to the Zip Code 
field if necessary. 

Tip: To enter an overseas military mailing code, such as AA, AE, or AP, the user must select the correct 
APO/FPO code from the drop-down list. 
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Zip Code: - A required field. Type the traveler's zip code as either the standard five (5) digit zip code or 
add a dash and the four (4) digit extension if desired. For example; 78233 or 78233-4594. 

Phone: - This field is optional. If used however, the phone number may be entered in any desired 
format. Special characters such as dashes, parenthesis, and commas are allowed. This will 
accommodate OCONUS phone numbers. Press Tab, when finished, to continue. 

Ext: - This field is optional. Type the (4) digit extension, if applicable, and press Tab. 
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Entering Office Address Information 

The traveler's office address information is used to store the address and phone number for the 
traveler. This is historical information in case the travel office elects to send correspondence or 
contact the traveler at his/her place of business. 

Complete the following input fields, in the screen shown below, to "enter" a traveler's Office 
Address/Contact information: 

 

Tip: After making the required entries on at Personal tab, click on the Address/Contact Information 
tab to display the Mailing Address, Office Address, and E-mail Address sections. 

Note: The traveler's Office Address information is optional and does not have to be entered. 

Address-1: - Type the first line of the traveler's mailing address and press Tab. 

Address-2: - This field is used to add an Apt. #, P.O. Box, etc. Type the desired entry, if applicable, and 
press Tab. 

City: - Type the name of the city where the traveler receives mail. Type APO or FPO on this line if the 
traveler has an overseas military mailing address. 

State/Country: - For CONUS locations, type the two letter state code. If unknown, enter the letter the 
state begins with, then click on the Up/Down arrow keys until the desired state is highlighted. Press Tab 
or click on the highlighted item. For an OCONUS location, type the first letter of the country code. If the 
desired country is not highlighted, click on the Up/Down arrows to highlight the desired locality code. 
Press Tab or click on the highlighted item. Press Tab, to move to the Zip Code field if necessary. 
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Tip: To enter an overseas military mailing code, such as AA, AE, or AP, the user must select the correct 
APO/FPO code from the drop-down list. 

Zip Code: - A required field. Type the traveler's zip code as either the standard five (5) digit zip code or 
add a dash and the four (4) digit extension if desired. For example; 78233 or 78233-4594. 

Phone: - This field is optional. If used however, the phone number may be entered in any desired 
format. Special characters such as dashes, parenthesis, and commas are allowed. This will 
accommodate OCONUS phone numbers. Press Tab, when finished, to continue. 

Ext: - This field is optional. Type the (4) digit extension, if applicable, and press Tab. 
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Entering E-mail Address Information 

The traveler's e-mail address information is used to store the e-mail address for the traveler.  This is 
used to send correspondence or contact the traveler via an e-mail message. 

An e-mail address entered into this section is used by the E-mail for IATS feature to automatically attach 
the traveler's printed voucher to the e-mail address and be sent to the traveler. 

Complete the following input fields, in the screen shown below, to "enter" a traveler's E-Mail 
Address/Contact information: 

 

Tip: After making the required entries on at Personal tab, click on the Address/Contact Information 
tab to display the Mailing Address, Office Address, and E-mail Address sections. 

1. Is Active: - Click in this check box to activate the traveler's Email address. 
2. Primary Email Address: - Click in this field and type the traveler's Email address and then 

press Tab. 
3. Verify Primary Email Address: - Re-enter the traveler's Email address and then press Tab. 
4. Repeat the previous steps to add a Secondary Email Address if needed. 

Note: If the traveler is a civilian employee, click on the Miscellaneous Tab and review or make 
necessary changes to the Work Week section. 

5. Click the OK button to save the entries. 
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Entering Miscellaneous Information 

Note: For civilian travelers, this section assists in determining when Annual Leave is chargeable, if 
taken in-conjunction with a TDY trip. 

Complete the steps below to "change" to the traveler's Work Week information: 

 

Tip: After making the required entries at the Address/Contact Information tab, click on the 
Miscellaneous Tab to display the Work Week section. 

1. At the Hours worked per day field, the default value is eight hours. If necessary, delete the 
existing number and type the number that represents the correct hours for the employee's 
normal work day. Press Tab to continue. 

2. At the Select Days of Week Employee Works field, the default value is Mon - Fri. If correct, 
click the OK button. To select different days, click the box to the left of each regular work day for 
the employee. To un-select any of the default days, click in the box to the left of the particular 
day to remove the check mark. 

3. Click the OK button to save the entries. 
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Selecting Travel Accounts 

Before a Request for Advance or Settlement may be processed, the IATS user must select the travel 
account that is associated with the transaction being processed.  In addition, there are numerous other 
situations when the IATS user must first select a travel account before performing a particular 
function.  Some of these situations are listed below: 

 Viewing the Traveler's Profile 

 Viewing the Traveler's History Record 

 Selecting Travel Orders 

 Processing Collections 

Complete the following steps to "select" a travel account: 

 

1. At the Select Traveler screen, there are (2) methods for selecting a traveler account: 

 Method 1: - At the Search By field, click in the appropriate radio button to select your search 
by either SSN or DoD ID.  After making your selection, enter either the traveler's SSN or DoD ID 
at the corresponding input field and then press Tab. 

 Method 2: - Type the first (2) letters of the traveler's last name.  A listing appears displaying all 
travel accounts in the IATS database beginning with these (2) letters.  Click on the Up/Down 
arrows next to this listing or press the Up/Down arrow keys on the keyboard to scroll through 
the list.  When the desired traveler is highlighted, click on the highlighted listing. 

Note:  A new feature was added to IATS referred to as the DMDC Webcall.  This feature will only be 
used by select travel offices that have enabled a connection between the travel office and 
DMDC.  When a DoDID is entered into IATS and the DoD ID is not in the database, IATS will initiate an 
RBS (webcall) to DMDC to obtain the SSN for that traveler.  DMDC will do a real time web call lookup 
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using the DoDID and return in the results the SSN and travelerôs last name along with providing a 
DoDID match code.  The logic values/match codes returned should be evaluated by the user/examiner 
to determine if the value should be accepted or rejected based on the match code received.  If the user 
accepts the response, IATS will input this DoDID into the DoDID field into IATS.  If the user rejects the 
response from DMDC, IATS will not import the DoDID provided on the RBS and the user will need to 
correct the traveler name, or whatever mismatched information was provided on the response, then a 
new RBS can be initiated to obtain the SSN based on the new DoDID information.  

Below are examples of the messages a user may see when entering a DoDID into IATS and the DMDC 
Webcall feature is in use: 
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Modifying Travel Accounts 

On occasion, modification of an existing travel account is necessary. Additional information about the 
traveler may be needed, or existing data may need to be changed. 

Complete the following steps to "modify" a travel account: 
1. Login to IATS as an Examiner or System Administrator, and click on the Tools menu at the 

top of the IATS for Windows screen.  A drop down list of options appears. 

 
2. Click on the Traveler Profile option.  The Select Traveler screen appears. 

3. At the Select Traveler screen, click in the appropriate radio button to select your search by 
either SSN or DoD ID. 

4. After making your selection, enter either the traveler's SSN or DoD ID at the corresponding input 
field and then press Tab.  The Traveler Profile screen appears. 

 
5. When the Traveler Account screen appears, click in the desired field and type the required 

change. 

6. When finished modifying the travel account, click on the OK button to save the changes. 
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Viewing Travel Accounts 

On occasion, it may be necessary to view the traveler's account information. 

Complete the following steps to "view" a travel account: 

1. At the Examiner, Auditor or System Administrator View screen, click on the Tools menu. A 
drop down list of options appears. 

 

2. Click on the Traveler Profile option and the Traveler Selection screen appears. 
3. At the Select Traveler screen, click in the appropriate radio button to select your search by 

either SSN or DoD ID. 

4. After making your selection, enter either the traveler's SSN or DoD ID at the corresponding input 
field and then press Tab.  The Traveler Profile screen appears. 

 

4. When finished viewing the travel account, click on the OK or Cancel button. 
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View or Modify the Traveler's Account from Input Screens 

When processing travel pay transactions, the Traveler Profile screen can be viewed or modified from 
an input screen. 

Complete the following steps to "view or modify" a traveler profile from an input screen 

 

1. Click on the button at the top of the screen displaying the traveler's name.  IATS displays the 
Traveler Profile screen for this traveler. 
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2. When the Traveler Profile screen appears, the user may view the traveler's account information 
or modify the information as needed. 

3. When finished viewing or modifying the Traveler Profile screen, click on the OK button to save 
any changes and return to the previous input screen. 
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Deleting Traveler Profile 

As a travel voucher examiner, it may be necessary to delete traveler profiles on occasion.  This 
commonly occurs when the traveler has relocated to a new duty station and the account is no longer 
serviced by your office. 

Tip: A traveler profile cannot be deleted until all of the details (including travel orders) have been deleted 
first.  Refer to the Help topic, "Deleting Travel Orders" for additional instructions. 

There are two methods for deleting an existing traveler profile.  One method is performed from the 
Examiner View screen.  Using this method however, will only delete profiles that have no Open Items, 
Details, or Open Suspense Items. 

Note: Voucher examiners must have the privileges assigned to their user account that allow them to 
delete a traveler's profile. There are two specific privileges that apply to this process: 

 Delete Traveler Accounts Without Open Items. 

 Delete Travelers With No Details. 

Definitions: 

Details: - A detail is a travel order or a transaction such as an advance or a settlement that has been 
logged or processed and posted to the traveler's history record. 

Open Items: - An open item is a transaction such as an advance or a settlement that has been 
processed and posted to the traveler's history record, and no DOV# has been posted to the transaction. 

Open Suspense Items: - An open suspense item is an amount due the US associated with a particular 
travel order. This can be the result of an unsettled advance or a settlement that was processed 
resulting in an amount due the US. 

The second method is performed from the System Administrator menu, which requires a special 
privilege.  Using this method, the user can delete any profile regardless of the condition.  Refer to the 
Help topic, "Delete Travel Account Details", for instructions on using this method. 

Complete the following steps to "delete" a Traveler Profile using the Examiner View: 

1. At the Examiner View screen, click on the Tools menu and select the Delete Traveler 
option.  The Select Traveler to Delete screen appears. 
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2. At the Select Traveler to Delete screen, click in the appropriate radio button to select your 

search by either SSN or DoD ID. 

3. After making your selection, enter either the traveler's SSN or DoD ID at the corresponding input 
field and then press Tab. 

4. When the traveler's account information appears, click on the Delete button.  The Confirmation 
Password screen appears. 

5. At the Confirmation Password screen, type the confirmation password at the Enter Password 
field and click the OK button. 

6. The Reason for Deletion of Claim and Traveler screen appears next. 
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7. Reason(s) for Deletion: - Notice that there are four Reason fields. You must select at least one 
reason by clicking on the down arrow button in one of the Reason fields and then click on a 
reason from drop down list of reasons. 

8. Reasons for Deletion of Traveler: - In the text box at this field, you must enter a remark. Click 
in the text box and type a remark. 

9. When you have finished selecting reasons and entering remarks, click on OK. 
10. If the travel account has any open transactions, suspense items, or Tax Records, a message 

appears indicating the situation and asking if you are sure you wish to delete the account. If sure, 
click the Yes button. 

11. IATS deletes the account and displays a pop-up message appears stating that the account was 
successfully deleted. 

12. Click on OK to return to the Examiner View screen. 
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Freeze Traveler Account 

This feature was added for situations where the traveler account was created incorrectly and claims have 
been processed.  By using this feature you may keep the historical data for the claim, (unless the account 
was deleted), but prevent users from accessing the incorrectly created account again. 

Complete the following steps to "freeze" a travel account: 

1. Login to IATS as a System Administrator, and click on the Tools menu at the top of the IATS 
for Windows screen. A drop down list of options appears. 

 

2. Click on the Traveler Profile option and the Select Traveler screen appears. 
3. At the Select Traveler screen, click in the appropriate radio button to select your search by 

either SSN or DoD ID. 

4. After making your selection, enter either the traveler's SSN or DoD ID at the corresponding input 
field and then press Tab. 

5. When the traveler's account information appears, click on the OK button. 
6. The Traveler Profile screen appears. 
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7. Click in the check box at the This traveler has been frozen field. 
8. Click on the OK button to save your entry. 
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Travel Orders 

Type of Orders 

Before a travel advance or settlement can be processed using IATS, a Travel Order must be 
created.  Travel Order information determines the specific entitlements, trip dates and establishes the 
limitations necessary for correct computation of the travel advance, or settlement. 

When creating travel orders, IATS requires the user to specify what type of order is being created. The 
type of travel order specified has a direct impact on the way IATS functions and the computation of the 
entitlement. Following, is a listing of the various types of travel orders that may be created: 

 Normal 

 Blanket 

 Repetitive 

 Invitational 

 MILPCS 

 CIVPCS 

 Local (1164) 

 Evacuation 

 Student 

Click on any of the types listed above for a link to the Help topic explaining the requirements for 
creating the selected type of travel order. 
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Creating Travel Orders 

Note: A traveler order may be created by an IATS user in the Examiner or System Administrator view if 
the privilege was established when the IATS user account was created. 

1. Login to IATS as an Examiner or System Administrator, click on the Tools menu at the top of 
the IATS for Windows screen.  A drop down list of options appears. 

 

2. Click on the Traveler Order option and the Select Traveler screen appears. 

 

3. At the Select Traveler screen, click in the appropriate radio button to select your search by 
either SSN or DoD ID.  After making your selection, enter either the traveler's SSN or DoD ID at 
the corresponding input field and then press Tab or click on the OK button.   

4. If the traveler's account does not exist in the database, a message appears asking if you wish to 
create a new traveler profile.  Selecting OK causes the Verify SSN field to appear. 
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5. Re-enter the traveler's SSN at the Verify SSN field and then click on OK. 

6. The Traveler Profile screen will now appear.  Complete this screen by following the steps 
covered in the topic "Creating Traveler Profile". 

7. After accessing the traveler's account or creating a new travel account, the Travel Order 
Selection screen appears. 
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8. Type the travel order number at the TONO field and click on the OK button.  A pop-up message 
appears indicating that the order does not exist and asking if you want to create it.  Click on the 
Yes button to continue. 

9. The Travel Order screen appears next. 

Refer to the Help topic, "Completing the Travel Order Screen", for additional instructions. 
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Completing the Travel Order Screen 

After entering a new travel order number at the Travel Order Selection screen, the Travel Order 
screen appears. 

This screen is used to capture the specific details for the trip and to approve the various entitlements 
necessary for the accomplishment of the mission.  In addition, it captures the funding information 
necessary for reporting the obligation and expenditures to the associated accounting systems. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal. If normal is the desired type, press 
Tab to continue.  If another type of order is desired, click on the down arrow to display a listing 
of various types and then click on the desired type to make a selection.  Refer to the topic "Type 
of Orders" for more specific details about the various types of travel orders. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record. This 
information is useful when conducting research or answering inquires.  At this field, click on the 
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down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 

 Max Trips Allowed: - Users can only access this field when the type of travel order is 
Repetitive. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering inquires. 
Press Tab to continue or type a different organization if desired.  

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering inquires. 
Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 UIC: - This field pertains to Navy customers only. The default value at this field is zeros.  You 
may leave the field as is or you may enter the UIC for the traveler.  The purpose of this field is to 
be able to generate the suspense reports for a specific UIC. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 Group Travel: - Click in the check box next to the Group Travel field if you must activate 
Group Travel rules for this travel order. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for advance or settlement.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date the travel is expected to begin, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for advance or settlement.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field.  That will cause 
IATS to automatically calculate the End Date for the trip.  Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

 Remarks: - If you wish to add remarks for the travel order you are creating, click on the 
Remarks tab and enter your desired remarks. 

After completing all of the required input fields, click the OK button to save the entries. 



IATS 8.7.3 User Guide 

137 

Entering Remarks on the Travel Order Screen 

There are times when travel office personnel may need to enter remarks associated with the travel 
order.  IATS includes a feature that will allow you to perform this action. 

The Travel Order screen has a tab that you may click on to enter any necessary remarks. 

 

If you wish to enter remarks, click on the Remarks tab.  When the Remarks tab is displayed, click in the 
text box and type your desired remarks. 

When you are finished entering the remarks, click on OK to save your entries. 
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Creating MILPCS Travel Orders 

Note:  For Navy users of IATS, if you are creating a travel order for a MILPCS Settlement or an 
Advance for a (DITY/PPM) transaction, refer to the Help topics "Transactional Accounting" for 
Settlements, or "DITY-PPM-Advances" if the transaction will involve Transactional Accounting. 

Creating an IATS Travel Order record for MILPCS travel, requires the user to specify what entitlements 
were authorized in accordance with the published orders. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal. Click on the down arrow button to 
display a listing of various types and then click on PCS. A selection can also be made by 
pressing the Up/Dn arrow keys on the keyboard to scroll through the listing of various types. 
When PCS is highlighted, it is automatically selected by IATS. 
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 Purpose of Trip: - The type of PCS selected affects the traveler's entitlements. At this field, 
click on the down arrow to display a listing of various choices and then click on the desired 
choice to make a selection. A selection can also be made by pressing the Up/Dn arrow keys on 
the keyboard to scroll through the listing of various types. When the desired type is highlighted, 
press Tab to make a selection. 

 Issuing Organization: - The default value, previously entered into the Organization field when 
the travel account was created, is displayed in this field. This information is posted to the 
travel order detail record, and may be useful when conducting research or answering inquires. 
Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created. This information is posted to the 
travel order detail record, and may be useful when conducting research or answering inquires. 
Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module. This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field. No input is 
necessary. 

 Group Travel: - Click in this box or press the space bar to activate this option if group travel 
rules apply to the MILPCS trip the order is being created for. IATS places a check mark in this 
box when group travel rules are activated. 

 Origin: - This is the location of the traveler's old Permanent Duty Station (PDS). At this field, the 
Location Selection screen automatically appears. At the State/Country field, type the first two 
letters of the state or country name. If necessary, click the Up/Dn arrows until the desired name 
is displayed. Click on the highlighted name or press Tab to make the selection. At the City or 
Locality field, type the first two letters of the city/locality name. This displays a listing of 
city/locality names, for the previously selected state, beginning with those letters. Use the 
procedures previously described to make the selection.  Click on OK to continue. 

 Destination: - This is the location of the traveler's new Permanent Duty Station (PDS). Use the 
same method explained at the Origin field to complete the Destination field. 

 Default State: - The name of the state for the member's new PDS destination will default to this 
field.  This is a view only field and cannot be changed. 

 State Tax Designation: - The state name entered into this field specifies which state the 
member has a tax obligation too.  IATS will use the tax rate for the state entered for calculating 
the state tax withholdings.  Enter the two character state code or click on the down arrow 
button and then click on the desired state name from the displayed list. 

 Issue Date: - At this field, type the date the order was issued, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for settlement or advance.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 Begin Date: - At this field, type the date the travel is expected to begin, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You 
can also click on the down arrow button and use the Calendar to select the date. 

 End Date: - At this field, type the date the travel is expected to end, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You 
can also click on the down arrow button and use the Calendar to select the date. 

After completing all of the required input fields, click on the Next button, the What's Authorized 
tab, or press the (Alt + N) keys to advance to the What's Authorized (Military PCS) tab. 
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What's Authorized - Military PCS Tab 

Creating an IATS Travel Order record for MILPCS travel, requires the user to specify what entitlements 
were authorized in accordance with the published orders. 

 

Complete this tab by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 TLA: - Click in this box or press the space bar to activate this option if the entitlement for 
Temporary Lodging Allowance is authorized.  IATS places a check mark in this box when the 
TLA entitlement is activated. 

 Ship POV: - Click in this box or press the space bar to activate this option if the traveler is 
authorized to ship a POV to or from an OCONUS location.  IATS places a check mark in this 
box when this option activated. 

 DLA: - The type of DLA selected affects the traveler's entitlements.  Click on the down arrow 
button to display a listing of various types and then click on the desired choice.  A selection can 
also be made by pressing the Up/Dn arrow keys on the keyboard to scroll through the listing of 
various types.  When the desired type is highlighted, press Tab to make a selection. 

 TLE: - Click in this box or press the space bar to activate this option if the entitlement for 
Temporary Lodging Expense is authorized.  IATS places a check mark in this box when the 
TLE entitlement is activated. 

 Emergency TLE: - Click in this box or press the space bar to activate this option if the 
entitlement for Temporary Lodging Expense is authorized in a declared disaster area.  IATS 
places a check mark in this box when the Emergency TLE entitlement is activated.  Checking 
this box allows for the payment of TLE up to a maximum of 60 days. 

 Increase Standard TLE: - This check box will only appear if the Begin Date on the Travel Order 
is prior to 10/01/22.  You should click in this box or press the space bar to activate this option if 
an extension to the entitlement for Temporary Lodging Expense has been approved and the 
TLE period started in September 2022 but crossed over into October 2022.  Checking this 
option will increase the allowable number of TLE days to up to 14. 
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 Paid BAH: - Click in this box or press the space bar to activate this option if the member 
received a payment for Basic Allowance for Housing (BAH) during the TLE period.  When this 
option is activated, IATS will reduce the lodging amount for days (15-60) of the TLE period by 
the daily BAH rate.   

 Has BAH Waiver: - Click in this box or press the space bar to activate this option if the service 
member provides an approved waiver.  When this option is activated, IATS will not reduce the 
lodging amount of TLE by the BAH daily rate. 

 Proceed Time: - Click in this box or press the space bar to activate this option if Proceed Time 
was authorized on the hard-copy travel order attached to the request for settlement or advance. 

 Separate COT Travel: - Click in this box or press the space bar to activate this option 
if  Separate Consecutive Overseas Travel (COT) was authorized. 

 Household Goods: - At this field, click on the down arrow button to display a listing of various 
types and then click on the desired choice.  A selection can also be made by pressing the 
Up/Dn arrow keys on the keyboard to scroll through the listing of various types.  When the 
desired type is highlighted, press Tab to make a selection. 

 CBA Authorized: - Click in this box or press the space bar to activate this option.  Note that 
this option applies to only Coast Guard and TPAX customers.  This option activates the 
requirement to flag claims for prepayment review or audit. 

After completing all of the required input fields, click on the Next button, the Dependents tab, or press 
the (Alt + N) keys to advance to the Dependents tab. 

After completing the Dependents tab, if applicable, click on the Next button, the Remarks tab, or press 
the (Alt + N) keys to advance to the Remarks tab if you wish to add some remarks to the travel order. 

Click on the OK button to save the travel order record once you have entered all of the applicable 
information. 
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Dependents - Tab 

Creating an IATS Travel Order record for PCS travel, requires the user to specify whether dependent 
travel was authorized, in accordance with the published orders, and who the dependents are. 

 

Note: Clicking on the Get Dependents button will automatically copy the dependent(s) information from 
another PCS travel order already in the database for this traveler. If there is not another PCS travel order 
in the database for this traveler, follow the steps below to add the dependent information. 

Complete this tab by entering the required information in each field as described below: 

Tip: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Dependent Name: - At this field, type the dependent's first name. 

 Relationship to Traveler: - At this field, a drop down list appears displaying various choices. 
Click on the desired choice or press the Up/Dn arrow keys until the desired choice is 
highlighted and then press Tab. 

 Date of Birth: - If Dependent was selected at the Relationship field, type the dependent's date 
of birth in MMDDYY format. 
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 Active Status: - If the dependent is a spouse, you must click on the down arrow button and 
then select either Active Military or Not Active Military. 

After completing the Dependents tab, if applicable, click on the Next button, the Remarks tab, or press 
the (Alt + N) keys to advance to the Remarks tab if you wish to add some remarks to the travel order. 

Click on the OK button to save the travel order record once you have entered all of the applicable 
information. 
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Creating CIVPCS Travel Orders 

Creating an IATS Travel Order record for CIVPCS travel, requires the user to specify what entitlements 
were authorized in accordance with the published orders. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal. Click on the down arrow button to 
display a listing of various types and then click on PCS.  A selection can also be made by 
pressing the Up/Dn arrow keys on the keyboard to scroll through the listing of various 
types.  When PCS is highlighted, it is automatically selected by IATS. 

 Purpose of Trip: - The type of PCS selected affects the traveler's entitlements.  At this field, 
click on the down arrow to display a listing of various choices and then click on the desired 
choice to make a selection.  A selection can also be made by pressing the Up/Dn arrow keys on 
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the keyboard to scroll through the listing of various types.  When the desired type is highlighted, 
press Tab to make a selection. 

 Issuing Organization: - The default value, previously entered into the Organization field when 
the travel account was created, is displayed in this field.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field. No input is 
necessary. 

 Origin: - This is the location of the traveler's old Permanent Duty Station (PDS).  At this field, the 
Location Selection screen automatically appears.  At the State/Country field, type the first two 
letters of the state or country name.  If necessary, click the Up/Dn arrows until the desired name 
is displayed.  Click on the highlighted name or press Tab to make the selection.  At the City or 
Locality field, type the first two letters of the city/locality name.  This displays a listing of 
city/locality names, for the previously selected state, beginning with those letters.  Use the 
procedures previously described to make the selection. 

 Destination: - This is the location of the traveler's new Permanent Duty Station (PDS).  Use the 
same method explained at the Origin field to complete the Destination field. 

 Default State: - The name of the state for the employees new PDS destination will default to 
this field.  This is a view only field and cannot be changed. 

 State Tax Designation: - The state name entered into this field specifies which state the 
employee has a tax obligation too.  IATS will use the tax rate for the state entered for 
calculating the state tax withholdings.  Enter the two character state code or click on the 
down arrow button and then click on the desired state name from the displayed list. 

 Payroll Office: - If the Payroll Office field is displayed, type the traveler's payroll office 
code.  This field will only be visible when this option has been activated at the System 
Configuration screen in the Maintenance module. 

 Issue Date: - At this field, type the date the order was issued, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for settlement or advance.  You can also click 
on the down arrow button and use the Calendar to select the date. 

 Begin Date: - At this field, type the date the travel is expected to begin, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You can 
also click on the down arrow button and use the Calendar to select the date. 

 End Date: - At this field, type the date the travel is expected to end, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You can 
also click on the down arrow button and use the Calendar to select the date. 

 Job Offered: - At this field, type the date the traveler was offered the new assignment or the 
date the transportation agreement was signed.  You can also click on the down arrow button 
and use the Calendar to select the date. 

 Retirement Code: - At this field, select the current retirement program in effect for the 
employee.  The code selected will affect the amount of employment taxes withheld.  Click on 
the down arrow button to display a listing of various programs and then click on the desired 
choice.  A selection can also be made by pressing the Up/Dn arrow keys on the keyboard to 
scroll through the listing of various programs.  When the desired choice is highlighted, press 
Tab to make a selection. 



Travel Orders 

146 

 WTA to be paid: - Determine if the traveler has elected to receive a WTA payment and activate 
this option if applicable.  Click in the box or press the space bar. IATS places check mark in 
this box when the option is activated. 

After completing all of the required input fields, click on the Next button, the What's Authorized 
tab, or press the (Alt + N) keys to advance to the What's Authorized (Civilian PCS) tab. 
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What's Authorized - CIVPCS Order 

Creating an IATS Travel Order record for CIVPCS travel, requires the user to specify what entitlements 
were authorized in accordance with the published orders. 

 

Complete this tab by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

Mileages 

 Miles Old Residence to Old Station: - At this field, type the number of miles the traveler 
commuted daily from the residence to the old duty station. 

 Miles Old Residence to New Station: - At this field, type the number of miles from the 
traveler's old residence to the new duty station. 

 Miles Old Station to New Station: - At this field, IATS will automatically populate the number of 
miles.  If the mileage does not automatically populate, however, type the number of miles from 
the traveler's old duty station to the new duty station. 

What's Authorized 
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 Miscellaneous: - Click in this box or press the space bar to activate this option if 
Miscellaneous Expense Allowance was authorized on the hard-copy travel order attached to the 
request for settlement.  IATS places a check mark in this box when this option activated. 

 House Purchase: - Click in this box or press the space bar to activate this option if Real 
Estate Expenses were authorized on the hard-copy travel order attached to the request for 
settlement.  IATS places a check mark in this box when this option activated. 

 Alt. Fuel Authorized: - Click in this box or press the space bar to activate this option if the 
Authorizing Official has approved the shipment or the use of an alternative fueled vehicle (AFV) 
in connection with the PCS move.  Such approval authorizes circuitous travel routes to 
accommodate vehicle ranges and fueling availability limitations.   

 Trailer: - Click in this box or press the space bar to activate this option if the traveler was 
authorized reimbursement for the movement of a house trailer on the hard-copy travel order 
attached to the request for settlement.  IATS places a check mark in this box when this option 
activated. 

 Student Travel: - Click in this box or press the space bar to activate this option if Student 
Travel was authorized for this travel order. 

 Renewal Travel: - Click in this box or press the space bar to activate this option if Overseas 
Renewal Travel was authorized on the hard-copy travel order attached to the request for 
settlement.  IATS places a check mark in this box when this option activated. 

 Ship POV: - Click in this box or press the space bar to activate this option if the traveler was 
authorized to ship a POV to or from an OCONUS location on the hard-copy travel order attached 
to the request for settlement.  IATS places a check mark in this box when this option activated. 

 Num POV: - Click in this field and enter the number of POVs being shipped if Ship POV was 
authorized. 

 Property Management: - Click in this box or press the space bar to activate this option if PM 
services were authorized on the hard-copy travel order attached to the request for settlement. 
IATS places a check mark in this box when this option activated. 

 House Sale: - If Real Estate Expenses were authorized on the hard-copy travel order attached 
to the request for settlement, click on the down arrow button to display a listing of various types 
and then click on the desired choice.  A selection can also be made by pressing the Up/Dn 
arrow keys on the keyboard to scroll through the listing of various types.  When the desired type 
is highlighted, press Tab to make a selection. 

 Household Goods: - At this field, click on the down arrow button to display a listing of various 
types and then click on the desired choice.  A selection can also be made by pressing the 
Up/Dn arrow keys on the keyboard to scroll through the listing of various types.  When the 
desired type is highlighted, press Tab to make a selection. 

 HHG Taxable Temp Storage: - Click in this box or press the space bar to activate this option if 
Non-temporary Storage of HHGs was authorized on the hard-copy travel order attached to the 
request for settlement.  IATS places a check mark in this box when this option activated. 

 Total # Taxable Storage Days Authorized: - At this field, type the number of days authorized 
on the hard-copy travel order attached to the request for settlement for Non-temporary Storage of 
HHGs. 

House Hunting 

 Employee: - Click in this box or press the space bar to activate this option if the employee was 
authorized to perform a round trip for the purpose of finding a new residence at the new PDS. 

 Spouse: - Click in this box or press the space bar to activate this option if the employee's 
spouse was authorized to perform a round trip for the purpose of finding a new residence at the 
new PDS. 

 Lump Sum: - Click in this box or press the space bar to activate this option if the employee 
was authorized to be reimbursed under the Lump Sum method for computing a Househunting 
trip. 

 Max. Days: - At this field, type the number of days authorized, on the hard-copy travel order 
attached to the request for settlement, for performing a Househunting trip. 
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TQSE 

 Type of TQSE: - If Temporary Quarters Subsistence Expense (TQSE) was authorized, on the 
hard-copy travel order attached to the request for settlement, click on the down arrow button to 
display a listing of various types and then click on the desired choice.  A selection can also be 
made by pressing the Up/Dn arrow keys on the keyboard to scroll through the listing of various 
types.  When the desired type is highlighted, press Tab to make a selection. 

Note:  Actual will no longer be listed as a TQSE type for orders issued on or after 1 February 2025. 

 Number of days at higher rate: - If Actual was selected as the type of TQSE reimbursement, 
enter the number of days the traveler should be reimbursed for TQSE at the higher rate for the 
settlement being processed.  Note that this option does not apply to travel orders issued on or 
after 1 July, 2024. 

 Maximum days on Lump Sum TQSE: - If Fixed was selected as the type of TQSE 
reimbursement, enter the maximum number of days, authorized, on the hard-copy travel order 
attached to the request for settlement, for the reimbursement of TQSE at the Fixed Rate. 

 TQSE Lump Sum Accepted Date: - At this field, type the date the employee accepted to 
receive a Lump Sum payment for TQSE, in MMDDYY format.  You can also click on the down 
arrow button and use the Calendar to select the date. 

 Total # TQSE Days Authorized: If Actual was selected as the type of TQSE reimbursement, 
enter the maximum number of days, authorized, on the hard-copy travel order attached to the 
request for settlement.  The default value is 60, but the user may enter any number between 1 
and 120. 

After completing all of the required input fields, click on the Next button, the Dependents tab, or press 
the (Alt + N) keys to advance to the Dependents tab. 

After completing the Dependents tab, if applicable, click on the Next button, the Remarks tab, or press 
the (Alt + N) keys to advance to the Remarks tab if you wish to add some remarks to the travel order. 

Click on the OK button to save the travel order record once you have entered all of the applicable 
information. 
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Creating Blanket Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

A Blanket Travel Order is used when the traveler will perform an unlimited number of trips against the 
same travel order number during a specified period. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: -  If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Blanket to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 
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 Issuing Organization: - The default value, previously entered into the Organization field when 
the travel account was created, is displayed in this field.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created. This information is posted to the 
travel order detail record, and may be useful when conducting research or answering inquires. 
Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module. This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field. No input is 
necessary. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for settlement or advance.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date for the beginning of the repetitive period, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You can 
also click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field. That will cause 
IATS to automatically calculate the End Date for the trip. Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary. If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

After completing all of the required input fields, click the OK button to save the entries. 
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Creating Repetitive Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

A Repetitive Travel Order is used when the traveler will perform a specified number of trips against the 
same travel order number during a specified period. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Repetitive to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 
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 Max Trips Allowed: - At this field, type the number of trips the traveler is authorized to perform 
against this order. 

 Taken or Advanced: - This field is a display to show how many trips were taken or advances 
were issued against this order. 

 Issuing Organization: - The default value, previously entered into the Organization field when 
the travel account was created, is displayed in this field.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for settlement or advance.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date for the beginning of the repetitive period, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You can 
also click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field.  That will cause 
IATS to automatically calculate the End Date for the trip.  Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

After completing all of the required input fields, click the OK button to save the entries. 
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Creating Invitational Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

An Invitational Travel Order is used when the traveler is not a member or employee, but has been 
invited to perform travel on behalf of the US Government.  

Travel and transportation allowances authorized for these individuals are the same as those ordinarily 
authorized for employees performing TDY. 

 

Complete this screen by entering the required information in each field as described below: 

TIP:  After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Invitational to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
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down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering inquires. 
Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for advance or settlement.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date the travel is expected to begin, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for advance or settlement.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field.  That will cause 
IATS to automatically calculate the End Date for the trip.  Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

After completing all of the required input fields, click the OK button to save the entries. 
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Creating Local (1164) Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

A Local Travel Order is used when the travel is performed within the Local Travel Area of the traveler's 
PDS. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Local (SF1164) to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 
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 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for advance or settlement.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date the travel is expected to begin, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for advance or settlement.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field.  That will cause 
IATS to automatically calculate the End Date for the trip. Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

After completing all of the required input fields, click the OK button to save the entries. 
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Creating Local Move Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

A Local Move Travel Order is used when a traveler is authorized reimbursement for the movement of 
household goods and Partial Dislocation Allowance, but is not associated with a Permanent Change 
of Station (PCS). 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Local Move to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
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down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for advance or settlement.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date the travel is expected to begin, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for advance or settlement.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field.  That will cause 
IATS to automatically calculate the End Date for the trip.  Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

 Partial DLA Authorized: - Click in the check box to select this entitlement if authorized. 

After completing all of the required input fields, click the OK button to save the entries. 
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Creating Evacuation Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

An Evacuation order is created when the travel must be performed due to the authorized/ordered 
movement of dependents from a specific area, when authorized/ ordered by the appropriate authority. 

Evacuation refers to movement or departure from one area to another (both areas may be in the same 
city or country, or each may be in a different city or country). 

In addition, a new evacuation allowance was created for Service Members and their dependents when a 
localized emergency situation arises and the member must evacuate his/her home, (whether on base, 
off base, or privatized), obtain lodging in the local area, and may or may not continue to report to his/her 
duty station.   

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 
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 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Evacuation to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 

 Member Authorized Evacuation Allowance: - Click in the check box to select this option if the 
member has been authorized to receive evacuation allowances for a local emergency 
displacement.  Note that If this check box is un-checked, the order cannot be saved unless 
there are dependents listed on the Dependents tab. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 Disaster: - The default value at the Disaster field is None.  Clicking on the down arrow will 
display a list of named disasters from the Disaster Rates Table in the IATS Maintenance 
module. If the evacuation order is being created for a named disaster, click on the down arrow 
and then click on the applicable disaster name from the drop down list. 

 Evacuated From: - This is the location the traveler/dependent(s) are being evacuated from.  At 
this field, the Location Selection screen automatically appears.  At the State/Country field, type 
the first two letters of the state or country name. If necessary, click the Up/Dn arrows until the 
desired name is displayed. Click on the highlighted name or press Tab to make the selection.  At 
the City or Locality field, type the first two letters of the city/locality name.  This displays a 
listing of city/locality names, for the previously selected state, beginning with those letters.  Use 
the procedures previously described to make the selection.  Click on OK to continue 

 Designated Location: - This is the location of the traveler's/dependent(s) designated location 
(DL) to be used as a safe haven (SH).  Use the same method explained at the Evacuated from 
field to complete the Designated Location field. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for advance or settlement.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date the travel is expected to begin, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for advance or settlement.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

 Override Disaster Table: - If the evacuation travel order is being created for a named disaster 
that was selected from the listed disasters at the Disaster field, the Disaster Rates table in the 
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Maintenance module determines how many days the per diem is payable for at the higher 
rate.  In some cases, however, the command may have the discretion to determine how many 
days are payable at the higher rate.  If the command has the authority to extend the number of 
days payable at the higher rate, click in the check box at the Override Disaster Table field. 

 # of Days at High Rate: - If the check box was checked at the Override Disaster Table field, 
enter the number of days determined by the command for the payment of per diem at the higher 
rate. 

 Sponsoring Org: - The default value at the Sponsoring Org field is the traveler's paying 
organization.  If the evacuation travel, however, is being sponsored by an organization other 
than the traveler's paying organization, enter the name or unit number of the sponsoring 
organization at this field. 

After completing all of the required input fields on the Description tab, click on the Dependents and or 
Remarks tabs to complete the travel order. 
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Creating Student Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

The purpose of Student Travel is to send an employee's dependent on one round trip each year from 
the employee's OCONUS duty station to a school in the United States.  This type of travel requires the 
creation of a Student Travel order. 

 

Complete the Travel Order screen by entering the required information in each field as 
described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Student Travel to make a selection. 

 Purpose of Trip: - For Student Travel, the purpose of the trip will always default to Other. No 
action is necessary at this field. 
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 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 School Destination: - When you advance to the School Destination field, the Location 
Selection screen will appear and you must specify the exact location of the school the student 
will attend.  At the State/Country field, type the first two letters of the state or country name.  If 
necessary, click the Up/Dn arrows until the desired name is displayed.  Click on the highlighted 
name or press Tab to make the selection. At the City or Locality field, type the first two letters of 
the city/locality name. This displays a listing of city/locality names, for the previously selected 
state, beginning with those letters.  Use the procedures previously described to make the 
selection.  Click on OK to continue. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for advance or settlement.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date the travel is expected to begin, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for advance or settlement.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 End Date: - Type the date the travel is expected to end, in MMDDYY format, as shown on the 
hard-copy travel order attached to the request for advance or settlement.  You can also click on 
the down arrow button and use the Calendar to select the date. 

After completing all of the required input fields on the Description tab, click on the Dependents and or 
Remarks tabs to complete the travel order. 
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Creating TDY with DITY Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

A TDY with DITY Travel Order is used when a traveler is authorized reimbursement for the movement 
of household goods in conjunction with a TDY trip. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the Down arrow to display a 
listing of various types and then click on TDY with DITY to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 
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 TDY DITY Authorized: - A check mark appears in the check box next to this item when TDY 
with DITY is selected as the order type.  Click in the box to un-check it if a DITY move is not 
authorized in conjunction with the TDY trip. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 Group Travel: - Click in this box or press the space bar to activate this option if group travel 
rules apply to the trip the order is being created for.  IATS places a check mark in this box when 
group travel rules are activated. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for settlement or advance.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date for the beginning of the repetitive period, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You can 
also click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field.  That will cause 
IATS to automatically calculate the End Date for the trip.  Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

After completing all of the required input fields on the Description tab, click on the Remarks tab if you 
wish to add remarks to the order or click on OK if you are done. 
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Creating Taxable TDY Orders 

This feature applies to civilian travel only. 

After entering a new travel order number at the Travel Order Selection screen, the Travel Order 
screen appears. 

This screen is used to capture the specific details for the trip and to approve the various entitlements 
necessary for the accomplishment of the mission.  In addition, it captures the funding information 
necessary for reporting the obligation and expenditures to the associated accounting systems. 

 

Complete this screen by entering the required information in each field as described below: 

TIP: After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement. 

 Order Type: - The default order type at this field is normal.  If normal is the desired type, press 
Tab to continue.  If another type of order is desired, click on the down arrow to display a listing 
of various types and then click on the desired type to make a selection.  Refer to the topic "Type 
of Orders" for more specific details about the various types of travel orders. 
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 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, click on the 
down arrow to display a listing of various choices and then click on the desired choice to make 
a selection. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 UIC: - This field pertains to Navy customers only. The default value at this field is zeros.  You 
may leave the field as is or you may enter the UIC for the traveler.  The purpose of this field is to 
be able to generate the suspense reports for a specific UIC. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 Group Travel: - Click in the check box next to the Group Travel field if you must activate 
Group Travel rules for this travel order. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for advance or settlement.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date the travel is expected to begin, in MMDDYY format, as shown on 
the hard-copy travel order attached to the request for advance or settlement.  You can also 
click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field.  That will cause 
IATS to automatically calculate the End Date for the trip.  Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 Taxable TDY: - IATS automatically checks this field to apply tax withholdings for TDY trips in 
excess of 365 days.  Click in the check box to remove the check mark if taxes should not be 
withheld. This feature applies to civilian travel only. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary.  If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

 Remarks: - If you wish to add remarks for the travel order you are creating, click on the 
Remarks tab and enter your desired remarks. 

After completing all of the required input fields, click the OK button to save the entries. 
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Creating Alaska Leave Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

Alaska Leave Travel Orders are created when a member, assigned to a Permanent Duty Station (PDS) 
in Alaska, is authorized the special leave transportation allowance reimbursement for one round trip 
airfare between the member's PDS and Home of Record (HOR).   

Note: This entitlement is effective December 23, 2022 to December 31, 2023.  

 

Complete this screen by entering the required information in each field as described below: 

Tip:  After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 

 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Alaska Leave to make a selection. 
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 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, IATS will 
automatically default to Alaska Leave Allowance as the purpose. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 State Tax Designation: - The State Tax Designation field appears on the Travel Order screen if 
the option to withhold state taxes is activated in Maintenance.  This field is used to specify 
which state withholding taxes should be withheld for.  Enter the two character abbreviation for 
the desired state or click on the down arrow button and then click on the correct state name 
from the drop down list. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for settlement or advance.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date for the beginning of the repetitive period, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You can 
also click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field. That will cause 
IATS to automatically calculate the End Date for the trip. Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary. If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

After completing all of the required input fields, click the OK button to save the entries. 
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Creating Mobilization Travel Orders 

Creating an IATS Travel Order record, requires the user to specify what entitlements were authorized 
in accordance with the published orders. 

Mobilization Travel Orders must be created when a member or employee assigned to a Permanent Duty 
Station (PDS), is ordered to participate in a contingency operation that requires mobilization. 

Due to a new requirement to show Mobilization/Demobilization and TDY expenses on separate 
accounting lines and separated by fiscal year some new features were added to IATS to handle these 
requirements. 

One of the key new features is the ability to turn on the Mobilization Travel feature when creating the 
Travel Order. 

 

Complete this screen by entering the required information in each field as described below: 

Tip:  After entering the required information at an input field, press Tab or click in the next field to 
continue. 

 Order Number: - If not previously entered at the Travel Order Selection screen, type the travel 
order number as shown on the hard-copy travel order attached to the request for settlement or 
advance. 
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 Order Type: - The default order type at this field is normal.  Click on the down arrow to display a 
listing of various types and then click on Alaska Leave to make a selection. 

 Purpose of Trip: - The data input to this field is posted to the travel order detail record.  This 
information is useful when conducting research or answering inquires.  At this field, IATS will 
automatically default to Alaska Leave Allowance as the purpose. 

 Issuing Organization: - The default value previously entered into the Organization field, when 
the travel account was created, is displayed in this field.  This information is posted to the travel 
order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 Paying Organization: - The default organization displayed is the information entered into the 
Organization field when the travel account was created.  This information is posted to the 
travel order detail record, and may be useful when conducting research or answering 
inquires.  Press Tab to continue or type a different organization if desired. 

 DSSN ITR: - The default number displayed is from the DSSN ITR field at the Maintain Base 
Description screen in the Maintenance module.  This number is used to identify the source of 
the payment when the payment is disbursed at a DSSN located other than where the voucher 
was computed. 

 Funds: - The type of customer IATS is configured for defaults to this field.  No input is 
necessary. 

 Mobilization: - Click in the check box to activate this option if the issued travel orders indicate 
that the purpose is in support of a contingency operation.  Activating this option will turn on 
new features added to IATS that will enable the ability to show Mobilization/Demobilization and 
TDY expenses on separate accounting lines separated by fiscal year. 

 Issue Date: - Type the date the order was issued, in MMDDYY format, as shown on the hard-
copy travel order attached to the request for settlement or advance.  You can also click on the 
down arrow button and use the Calendar to select the date. 

 Begin Date: - Type the date for the beginning of the repetitive period, in MMDDYY format, as 
shown on the hard-copy travel order attached to the request for settlement or advance.  You can 
also click on the down arrow button and use the Calendar to select the date. 

 Number of Days: - If desired, type the number of days for the trip at this field. That will cause 
IATS to automatically calculate the End Date for the trip. Press Tab to bypass this field if you 
would prefer to enter the End Date rather than have it calculated by IATS. 

 End Date: - If the number of days for the trip was previously entered at the Number of Days 
field, no action is necessary. If not, type the date the travel is expected to end, in MMDDYY 
format, as shown on the hard-copy travel order attached to the request for advance or 
settlement.  You can also click on the down arrow button and use the Calendar to select the 
date. 

After completing all of the required input fields, click the OK button to save the entries. 
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Selecting Travel Orders 

Essentially, all travel pay transactions require the use of a travel order.  Before a Request for Advance 
or Settlement may be processed, the IATS user must select the travel order that is associated with the 
transaction being processed. 

Complete the following steps to "select" a travel order: 

1. At the Travel Order Selection screen, any orders for the selected traveler are listed in the Order 
grid. 

 

2. Select an order through one of the following methods: 

 Method 1: - Double click on the desired order number. 

 Method 2: - Click on the order number once and then click the OK button. 
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 Method 3: - Enter a new travel order number at the TONO field.  If a non-existing order number 
is entered, a pop-up message appears asking if you want to create the order.  If you click on 
Yes, the Travel Order screen appears and you must create a new travel order. 
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Viewing Travel Orders 

On occasion, an IATS user may need to view an existing travel order to answer an inquiry or verify 
authorizations. 

Note: Travel Orders may be viewed by IATS users in either the Examiner or System Administrator 
view if the privileges were granted when the user account was created. 

Complete the following steps to View a Travel Order: 

1. Login to IATS and change the view to Examiner or System Administrator, if applicable. 

2. At the Examiner View or System Administrator View screen, click on the Tools menu and 
select the Travel Order option.  The Select Traveler screen appears. 

 

3. At the Select Traveler screen, click in the appropriate radio button to select your search by 
either SSN or DoD ID.  After making your selection, enter either the traveler's SSN or DoD ID at 
the corresponding input field and then press Tab. 

4. When the traveler's account information is displayed, click on OK.  The Travel Order Selection 
screen appears. 
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5. At the Travel Order Selection screen, any existing travel orders in the database for the selected 

traveler are listed in the table in the Order grid. 

6. Click on the desired order and IATS highlights the order in dark blue. After selecting an order 
click the OK button.  The Travel Order screen appears. 

Tip: An order may also be selected by double clicking on the desired order. 
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Note:  A remark displayed under the Order Number/TONO field, as shown above, indicates that the 
order number was changed.  Clicking on this remark will jump you to the Changed Order Number 
Report that will provide additional details regarding the number change. 

7. When finished viewing the order, click on the OK button. 
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View or Modify the Travel Order from Input Screens 

When processing travel pay transactions, the Travel Order screen can be viewed or modified from an 
input screen. 

Complete the following steps to "view or modify" a travel order from an input screen: 

 

1. Click on the TONO button at the top of the screen displaying the travel order number. IATS 
displays the Travel Order screen for this travel order number. 



IATS 8.7.3 User Guide 

179 

 

2. When the Travel Order screen appears, the user may view the travel order information or 
modify the information as needed. 

Note:  A feature was added to IATS to allow the user to change the traveler's Grade/Rank at the Travel 
Order screen and have this change update the traveler's profile if desired. 

3. If changing the traveler's Grade/Rank, click on the down arrow button at the Grade/Rank field 
to display a list of ranks or grades. 

4. Click on the desired grade or rank you wish to change the current grade or rank to. 
5. IATS will display the new grade or rank with a red background as shown below. 

 

6. Click on the OK button, to save your changes. 
7. If a change has been made to the traveler's grade or rank, IATS will display the following pop-

up message asking if you want update the traveler's profile with this change. 
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8. Click on Yes or No as desired. 

Note:  Another feature was added to IATS to allow the user to change the traveler's Retirement Code 
after an order has been created and saved. 

 

1. At the Description tab on the Travel Order screen, click on the down arrow button at the 
Retirement Code field as shown above to display a list of Retirement Codes. 

2. Click on the desired code.  IATS will display the following pop-up message. 

 
























































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































